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Unpacking and Inspection
After unpacking NuVerb, save all packing materials in case you ever need to ship the unit. Thoroughly inspect NuVerb and packing materials for
signs of damage. Report any damage to the carrier at once; report equipment malfunction to your dealer.

Lexicon Part #070-09486

CAUTION

Copyright 1993, Lexicon Inc.
All Rights Reserved.

Printed in the U.S.A.

Lexicon Inc.
3 Oak Park
Bedford, MA 01730
Tel 781-280-0300
Fax 781-280-0490

Apple, the Apple logo, and Macintosh are registered trademarks of Apple Computer, Inc.
NuBus is a trademark of Texas Instruments

RISK OF ELECTRIC SHOCK
DO NOT OPEN

This triangle, which appears on
your component, alerts you to
important operating and main-
tenance instructions in this ac-
companying literature.

This triangle, which appears on
your component, alerts you to
the presence of uninsulated,
dangerous voltage inside the
enclosure... voltage that may be
sufficient to constitute a risk of
shock.

Notice
This equipment generates and uses radio frequency energy and if not installed and used properly, that is, in strict accordance with the manufacturer's
instructions, may cause interference to radio and television reception. It has been type tested and found to comply with the limits for a Class A
computing device in accordance with the specifications in Subpart J of Part 15 of FCC Rules, which are designated to provide reasonable protection
against such interference in a residential installation. However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause interference to radio or television reception, which can be determined by turning the equipment OFF and ON, the user
is encouraged to try to correct the interference by one or more of the following measures:

Reorient the receiving antenna
Relocate the computer with respect to the receiver
Move the computer away from the receiver
Plug the computer into a different outlet so that the computer and receiver are on different branch circuits.

If necessary, the user should consult the dealer or an experienced radio/television technician for additional suggestions. The user may find the
following booklet prepared by the Federal Communications Commission helpful:

"How to identify and Resolve Radio/TV Interference Problems."

This booklet is available from the U.S. Government Printing Office, Washington, DC 20402, Stock No. 004-000-00345-4.

Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la class A
prescrites dans le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications du Canada.
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1
Getting Started

Introduction
Congratulations on your purchase of NuVerb — and welcome to the next generation of effects
processing technology. NuVerb provides the first comprehensive approach to effects creation
and automation, and brings Lexicon’s world-class digital signal processing technology to the
exciting arena of the desktop.

NuVerb's graphic interface allows you to create custom programs faster and easier. FX
Automation™   frees you from dealing  with  effects as static events and lets you enter the world
of true real-time effects processing.

NuVerb provides a palette of sophisticated effects, each containing a wide assortment of
parameters which can be adjusted to customize each sound. Parameters can also be automated
via time code. You can easily create a wide range of effects — from halls and chambers to totally
wild spaces — the possibilities are endless.

The Operating Modes
NuVerb contains two DSP processors  which can be configured to run in three different modes:
Single, Dual Mono, or Cascade. All NuVerb programs are designed to run in one of these three
modes. In the Single mode, the two processors are run as a single, unified machine. The Dual
Mono mode assigns one processor to each input. In the Cascade mode, the two processors are
arranged in a chain, so that processor A feeds processor B. This allows for a wide range of
interesting and useful sounds to be created, by mixing different effects together.
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The Programs
NuVerb programs are specifically designed to run in the single mode or in one of the “split”
modes (Dual Mono or Cascade). The programs available in Single Mode are: Random Hall,
Random Ambience, Rich Plate, and Stereo Adjust.

Random Hall  is a reverb program with a random element which allows a far more realistic hall
simulation than any conventional reverb.

Random Ambience creates early reflection simulation, with similarly brilliant results.

Rich Plate is a classic Lexicon plate effect, which is denser, smoother, and less colored than
conventional plates.

Stereo Adjust has been optimized for achieving perfect level, EQ, and Balance in a mastering
facility.

In the Dual Mono and Cascade modes, the available programs are: Split Chamber, Dual Delay,
Compressor, and PONS.

Split Chamber is a reverb program which provides a wide range of control over room
characteristics.

Dual Delay includes multiple stereo delay lines with two all-pass filters (diffusers).

The Compressor provides true digital look-ahead compression and expansion.

PONS  (Psychoacoustically-Optimized Noise Shaping) provides tools for properly truncating
and dithering 20-bit program material for distribution via 16-bit media.
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The Interface
NuVerb features the most user-friendly interface available in any digital effects processor.
Each program is presented as an on-screen diagram, with dynamic control available within the
diagram elements. Start with any program, and edit Input Level, Balance, and wet/dry Mix.
Then select the Effect Edit button to call up a diagram that lets you fine tune all of the effect
parameters. Depending on the program, these parameters include basic elements such as delay
time, feedback, decay time, and reverb level, and details such as room size, shape, diffusion,
and more. Each parameter is clearly marked and easily accessible: simply click to open an on-
screen fader that lets you change the value of any parameter. An edit/compare feature makes
it easy to hear your changes next to the original. A "Hot Palette" lets you assign your five most
frequently used parameters to faders that are always within easy reach.

For MIDI users, an extensive MIDI implementation is provided. Each NuVerb program can
have as many as ten parameters controlled via MIDI in real-time, and MIDI asignments can be
different for each NuVerb program. Reverse scalings can be assigned, and MIDI control can be
mapped across multiple NuVerb cards. NuVerb is compatible with both Apple MIDI Manager
and Opcode OMS.

FX Automation™
NuVerb revolutionizes the process of effects automation. This capability, which we call FX
Automation,™ gives you unprecedented, real-time control across multiple NuVerb cards. Far
beyond simple program changes, FX Automation™ makes any parameter, in any program,
available for real-time control. NuVerb offers not only extraordinary reverb and effects, but
also the ability to automate room ambience and effects changes via MIDI time code.
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Desktop Digital Reverb and Effects
Desktop production systems provide remarkable power and performance within a very small
working space, but, before NuVerb, they required sending audio out of a recorder, into an
effects system, and then back into the recorder. With NuVerb, the integrity of your signal is
never compromised by leaving the digital domain. Using multiple NuVerb cards with the
interface software offers massive control and automation, centralized in one system. NuVerb
offers greater flexibility, faster and easier programming, and world-reknowned Lexicon
sound — all accessible from the desktop.

How to use this manual
The manual is organized into four sections: Getting Started, Learning to Use NuVerb, Reference,
and Appendix.

Getting Started provides instructions for installing software and hardware, and for connecting
an audio source.

Learning to Use NuVerb contains a series of tutorials which introduce you to all of the features
of NuVerb.

These sections provide step-by-step guidance through procedures, with basic information
presented in bold text, followed by a more detailed explanation.

Reference contains a summary of keyboard shortcuts, illustrations of NuVerb windows and
menus, detailed descriptions of the NuVerb effects and their parameters, as well as MIDI
Implementation and time code data.

TheAppendix contains a troubleshooting guide and product specifications.

For those who don't read manuals: go to the Reference section and look at the examples
of NuVerb screen graphics for quick definitions of window and menu controls. See
NuVerb and MIDI to configure NuVerb to work with your system.



NuVerb User Guide Getting Started

5

5

Unpacking
Contents of Shipment

Your NuVerb package should contain a p.c. board, a cable, documentation, and two Macintosh
disks. Please note the manner in which these items are packed, and keep all packing materials,
in the event you need to re-ship your unit.

A: Sleeve
B: Box
C: Bottom foam insert
D: Middle foam insert (inter-

changeable with E)
E: Top foam insert  (inter-

changeable with D)
F: Documentation, disks

Use anti-static precautions
when handling NuVerb card.

• Avoid plastic, vinyl, or
styrofoam in the work area.

• Discharge personal static
before handling.

• Keep card in its static-proof
bag until installation.
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Installation
Setting Up

Setting up your Macintosh to run NuVerb requires the following steps:

• Installing the NuVerb Digital Reverb Effects Card into a NuBus slot

• Installing NuVerb software

• Connecting an AES digital audio source

• Setting up NuVerb to work with your MIDI system

Installing the NuVerb Digital Reverb Effects Card

Installing the Effects Card into a NuBus or Macintosh Expansion slot
1. Turn off the computer, and disconnect it from the power source.

The computer should remain unplugged for the entire installation procedure.

2. Place the computer on a clean, nonabrasive surface.

3. Place the anti-static bag containing the NuVerb card next to the computer.

Don't walk around with the card once it's removed from its anti-static bag, as moving your
feet may generate static electricity which can damage the card.

3. Follow the instructions provided with your particular computer model for removing the
cover.

4. Push out the plastic cover plate behind the expansion slot you want to use. (It doesn’t
matter which slot you choose.) Set the cover plate aside.

Press down on the clip at the top of the cover plate to release the plate. If you have difficulty
releasing the plate, use a screwdriver to press the clip.

5. Touch the metal part of the power supply case inside the computer to discharge any
static electricity that might be on your clothes or body.

Always do this before you touch any parts, or install components inside the computer.
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6. Remove the NuVerb Effects Card from its static-proof bag.

Hold the card by its top edge. Avoid touching the connector on the bottom of the card. If
you lay the card down, make sure to place it on its static-proof bag.

7. Align the card over the Expansion slot.

You may have to push the card toward the back of the computer chassis to do this, as there
are small, spring-loaded metal tabs on the slots.

Once the card is aligned, press firmly to
seat the card into the connector.

Hold the card by its upper edge.

8. Press down firmly on the card until the connector is seated.

Don’t force the card. If you meet a lot of resistance, pull the card out, and inspect the
connector to make sure that none of the pins are bent. Try seating the card again.

To see if the card is properly connected, lift it gently. If it resists and stays in place, it’s
connected.

9. Replace the cover on the computer.

Refer to the instructions provided with your particular Macintosh model. Do not operate
the system without the cover.
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Installing NuVerb Software

System Requirements
NuVerb requires at least 8 megabytes of RAM. The application itself uses only 4 megabytes,
but the Macintosh operating system also requires memory. Any software you run along with
NuVerb will have additional memory requirements. Refer to the manufacturer's specifica-
tions.

The behavior of NuVerb screens and faders is affected by the speed of your Macintosh. Note
that black and white monitors tend to run the NuVerb graphic interface faster than color
monitors. If you have a slower computer and/or a demanding application, you may want to
run NuVerb in black and white.

Installing the Application
1. Insert the NuVerb application disk into your drive.

As with all applications, it is recommended that you make a copy of this disk and work
from the copy, keeping the original in a safe place.

2. Create a new folder and name it “NuVerb.”

3. Insert the Program disk and double click on it.

The window should look like this:

NuVerb Read Me First
Any new items or changes will be
documented in this file. Double click
to open, and read the latest break-
ing items.

System Folder Items
Items that need to be placed in the
System Folder

System Extensions
Items that need to be placed in the
System Extensions Folder

NuVerb .sea
A compressed copy of the NuVerb
application

Apple Menu Items
Items that need to be placed in the
Apple Menu Folder

TeachText
An application that allows the
“NuVerb Read Me First” file to be
read.
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3. Select all of the items on the disk and copy them to the NuVerb folder you created.

4. Eject the NuVerb disk and store it safely, as this is your original master copy.

5. Open the NuVerb folder and double click on the NuVerb .sea icon.

 This starts the installation process.  During the installation, you will be asked to select a
location for the application. Although the application can be located anywhere you like,
we recommend selecting the newly-created NuVerb folder as the destination, in order to
keep all your NuVerb items together.

Installing MIDI Manager
NuVerb uses MIDI Manager   for Automation to support the communication of real-time
information such as MTC (MIDI Time Code) between applications. As MTC is necessary for
control of NuVerbFX Automation,™ the use of MIDI Manager is required.

Although Apple provides a driver with MIDI Manager, a number of manufacturers whose
software uses MIDI Manager provide their own drivers. NuVerb supports the use of most of
these. Check for updated information shipped with the NuVerb package, or included in the
NuVerb Read Me First file which is part of the NuVerb software package.

To install MIDI Manager:

1. Open the folder labeled Apple Menu Items. Select all of the items in this folder, and copy
them to the Apple Menu Folder.

2. Open the folder labeled System Folder Items. Select all of the items in this folder, and copy
them to the System Folder.

3. Open the folder labeled System Extensions. Select all of the items in this folder, and copy
them to the System Extensions Folder.

If you encounter problems in installing NuVerb software, refer to Troubleshooting in the
Appendix.
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Connecting an AES Audio Source

Cables/Connections
1. Use the cable provided with NuVerb.

NuVerb is supplied with a cable with aDB-9 connector for attachment to your Mac and an
XLR connector for attachment to your AES/EBU source.

2. If you do not have the correct cable, contact Lexicon or your NuVerb dealer for a
replacement.

To insure the integrity of digital communications, audio cable extenders or adapters
should be made using Belden #9271, or Manhattan #M4159.

FEMALE MALE
DB9 PIN XLR XLR FUNCTION

1 1 1 CHASSISGROUND
2 3 - AES IN (-)
3 - - N/C
4 - 2 AES OUT (+)
5 - - N/C
6 2 - AES IN (+)
7 - - N/C
8 - 3 AES OUT (-)
9 - - N/C
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Connecting an Analog Audio Source
NuVerb can be used with a traditional analog mixing console using an analog-to-digital/
digital-to-analog converter that provides an AES output from analog and also converts AES
back to analog. These are available from several manufacturers.  Also, check for updated
information shipped with the NuVerb package, or included in the NuVerb Read Me First file
which is part of the NuVerb software package.

The connection between your Macintosh and any A/D-D/A converter is via AES connectors.
See Cables/Connections as well as the information provided by the converter manufacturer for
specific cable requirements.

Note that NuVerb is slave device and will use the AES sample clock supplied to its input from
the A/D converter.
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2
Learning to Use NuVerb

Tutorial 1: Starting NuVerb
Once  you have successfully completed hardware and software installation,  you are ready to
open NuVerb. This tutorial assumes you have an audio source connected directly via AES, or
via an analog converter, and are monitoring the output of NuVerb. Select a piece of program
material to audition while doing this tutorial. If you have any questions about audio connec-
tions, refer to the Audio Connections  section in the previous chapter.
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Open NuVerb
To open NuVerb, double click on the NuVerb program icon.

When opened, NuVerb will create a default library of programs and open them in a Library
window on your screen. If this does not happen, select Create Default Library from the
Options menu. The default library will open with Large Hall selected.

You can open as many default libraries as
you want. They will open as "Untitled 1",
"Untitled 2", etc.

A control panel on each library al-
lows you to load and edit programs,
and to assign libraries to different
NuVerb cards.
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Creating and Loading Programs
A new program is created simply by copying one of the factory default programs, editing
it and renaming it.

Highlight Large Hall  and select Copy from the Edit menu. This places a copy of the program
into the Macintosh clipboard. Next, select Paste from the Edit menu. This pastes a copy of Large
Hall  above the original selection in the Library listing.

(Note that the NuVerb Cut, Copy, and Paste commands are also available via the familiar
Macintosh keystrokes: Command X,  Command C, and Command V.)

Now, select any other program in the Library listing  (in our example, we've selected Rooms),
and type Command V again.

Another copy of Large Hall  is pasted above the program you selected, and becomes  the selected
program. Copied items are always inserted above the currently selected program. If no
program is selected, copied items are pasted at the end of the library.

Select a program... The clipboard contents (in this case, a copy of
the program Large Hall) will be inserted above
the selected program, and will become the
current selection.

... Type Command V (or select
Paste from the Edit menu)...
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To load a selected program, click on the Program Load button, or click on the program you
want loaded.

For example, with one of your new copies of Large Hall. highlighted, click on the Load Program
button at the bottom of the library . This loads the program, and lets you  hear the sound of this
reverb program on your program material.

To load a program,  position the pointer over
the Load Program button and click.Loading
on a single click is an option which we have
selected for you. This can be disabled under
Preferences.

To open the Program Editor for any
program, position the pointer over the
Edit Program button and click...

... or double-click on the
program name.

Edit a program

The Program Editor
Open the Program Editor to change the program name, to edit effect parameters, or to set up
MIDI and the Hot Palette. Click on the Edit Program button, or double click on the program
name.
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The Program Editor opens to show a graphic overview of the program, and a panel of edit
buttons. The overview shows only the general program type (single, dual mono, or cascade)
and allows basic level and balance adjustments to be made within the diagram’s parameter
boxes. This Program Edit view is the most general view of the program and its effects,
presenting the least detail about them. Note that clicking on the Program Edit  button on the
control panel will always return you to this view.
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Select a parameter
To select a parameter, position the pointer over a parameter box and click.

For this example, click and hold on “Out Mix”. A heavy black outline around the “Out Mix”
parameter box indicates that it is selected.

Change the value of a parameter
Click on a selected parameter to pop up a fader. Double click on any unselected parameter
to select it and open a fader.

Single click on the selected parameter, in this case,  “Out Mix”.  A fader will pop up. Position
the pointer over the head of the fader control fader adjustment with the mouse. (Click and drag
also works for fader manipulation — the fader disappears when you release the mouse.)

The parameter value changes as the fader is moved with the mouse. Once you have selected
a value, click once, or press enter  on the keyboard, to hide the fader.

Double click on a parameter box to
select it and to pop up a fader.

Use the mouse, or the keyboard ↑ and ↓
keys to move the fader and adjust the
parameter value.

 Holding option while adjusting with the ↑ and ↓ keys on the keyboard gives you fine control
of certain parameters with large value ranges, such as delay time.
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Viewing Effects
To look at the currently running effect in greater detail, click on the box labeled “EFFECT
EDIT”, or click on the Effect Edit button on the Control Panel.

 To display  effect parameters,
click on the EFFECT EDIT box ...

... or the Effect Edit button.

When you select Effect Edit, the view changes to show a second level of detail, with additional
parameters, any of which can be altered with a fader as described earlier.



LexiconLearning to Use NuVerb

20

20

Note the box in the middle of the display, labeled REVERBERATOR. To access the reverb
parameters within this box, click on it, or on the Reverb Edit  button on the Control panel.

 To display  details of the Reverberator,
click on the REVERBERATOR box ...

... or the Reverb Edit button.

The view changes once again to display a third level of detail.

The Reverberator parameters are also available for fader adjustment. This is the deepest level
of detail of this effect.

Click on Effect Edit to return to the previous view.



NuVerb User Guide Learning to Use NuVerb

21

21

The available views depend on the number of parameters in any given effect. For some effects
one level of detail is sufficient to represent all of the parameters. Others require a deeper level
of detail.

Dual Mono and Cascade programs contain two effects, labeled "A" and "B." These programs
have a duplicate set of Control Panel buttons available for accessing the parameters of the
second effect. The techniques for viewing and editing either effect are identical.

Naming Programs and Effects
Program and Effect names can be changed in the Program Editor.

Effect names can be changed in the Effect Edit view of the Program Editor; program names can
be changed in the Program Edit view. In either view, the name which is available for alteration
is highlighted. Click on the name to display a standard text insertion tool.

Names can have as many as 32 characters (including spaces). New names will be saved when
the program is stored in a library.

Saving a Program
Click on the Edit window close box to call a dialog box that allows you to save the program
in its current state.

Select a program, open the Edit window, and alter any parameters you want. Once you have
completed the changes you want, click on the close box in the upper left hand corner of the Edit
window.  A dialog box will appear allowing you to choose  Don't Save (Command N), Cancel,
or Save.

For this example, click on Save (or press enter on the keyboard). This saves the changes you
have made to the current library.
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Saving a Library
The standard Macintosh save command calls up a dialog box allowing you to save a library.

When working with libraries, it is a good idea to save the library regularly as you modify and
save programs within the library. To do this press Command S, or select Save from the Edit
menu. The dialog box allows you to save the library with a new name.

Library Management
New libraries are easy to create with the familiar Macintosh Cut, Copy and Paste commands.
Libraries can be assembled from any combination of existing libraries, including the factory
default library. Let's look at how this works.

The Default Library
Selecting  Create Default Library from the Options menu, creates a copy of a bank of factory-
designed programs.  The library, which opens as “Untitled,” is used as a template for creating
your own “custom” NuVerb program. You can open multiple copies of the default library.
These will open as “Untitled 2,” “Untitled 3,” etc. You can make as many changes as you like
to any of these libraries, the actual default programs are always stored and available in NuVerb
memory.
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Working with Multiple Libraries
NuVerb allows only one library at a time to be assigned to any NuVerb card. The Slot number
on the Library Control Panel indicates to which NuVerb card a particular library is assigned.

The first library opened is automatically assigned to the lowest slot number in your system.
Subsequent libraries will open with the slot location "Unassigned." Although you can perform
all editing functions on an unassigned library (including saving your edits), you will not be
able to load programs. Assigning the library to a card enables the audio for that library.

An On Line/Off Line toggle button is providedto allow you to use NuVerb as a software-only
application to edit libraries.

To enable audio, a library must be
assigned to a NuVerb card in your
system,  Click here to pop up a menu
of slot assignments.

Click here to use NuVerb "Off Line"
(as a software-only appplication) to
edit libraries.

To Create a New, Empty Library
Select Create New Library from the File menu.

To Copy a Program
Select a program by clicking on it, then select Copy from the File menu.  The program can now
be pasted into any open library, or into any new library you open.

To Paste a Program
Select Paste from the File menu. If a program is highlighted, the new program is pasted above
it. If no program is highlighted, the program is pasted at the end of the library.
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To Cut a Program
Select a program by clicking on it, then select Cut from the File menu. The highlighted program
is  removed. Cut programs can be pasted into another location within the same library, or into
another library. The program will be saved on the clipboard until another Cut or Copy
command overwrites it.

Cutting, Copying , and Pasting Multiple Programs
The selection of multiple programs for cutting or copying to a library is accomplished by using
either the shift or the Command key as follows:

The shift key: To select a group of adjacent programs, click on the first program in the group.
Then press and hold the shift  key while selecting the last program in the group. All of the
programs between the first program selected and the second will be highlighted.

The Command key: To add a non-adjacent program to a highlighted group, hold down the
Command key while clicking on the program you want to add.

Programs pasted from the clipboard are inserted above  any program which is highlighted.  If
no program in the list is highlighted, programs are inserted at the end of the list.  The original
order of multiple programs is maintained when they are cut, copied, or pasted.
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Keyboard commands for selecting parameters, changing values, and selecting
views

The following keyboard commands can be used as a substitute for mouse control within the
Edit window:

1. To cycle though the parameters displayed in any Edit window view:

Press tab
2. To pop up a fader on a selected parameter:

Press enter
3. To hide the fader:

Press enter
3. To adjust any selected parameter’s value:

Press ↑ or ↓
4. To move to a more detailed view:

Press Command ↓
To move up to a more general view:

Press Command ↑
4. To move from Effect A to Effect B:

Press Command →
To move from Effect B to Effect A:

Press Command ←
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Tutorial 2: The Hot Palette
The Hot Palette provides status information and selectable real-time controls for NuVerb. Like
a Toolbox in a graphics program, the palette always stays in front of other windows, as it
provides important, regularly-used information and control. When the NuVerb application is
opened, any NuVerb cards in your system are automatically located, and the card with the
lowest number is identified here under “Slot #.”

The Hot Palette allows you to control parameters without opening the edit window. Each
program can be assigned to have your five favorite parameters appear for immediate control
whenever the program is loaded.  Faders on the Hot Palette can be assigned to control more
than one parameter within a program. If you have more than one NuVerb audio card, faders
on the Hot Palette can also be assigned to control programs running on different cards. Before
starting the tutorial, familiarize yourself with the parts of the Hot Palette, as shown on the
following page, and connect an audio source, as described in Tutorial 1.
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Clicking here opens an information display
showing Hot Palette fader assignment and
NuVerb card slot data.

The currently loaded program is displayed here.
This is especially useful when several libraries
are open on the desktop.

Click here to mute NuVerb effects,
or to pass a dry signal directly
through.

This label indicates which
NuVerb card is assigned to
Hot Palette control.

On Line indicates that the NuVerb card is
being controlled by the Macintosh
NuVerb application. Off Line allows the
NuVerb application to be run in a
Macintosh that does not have a NuVerb
card, for the purpose of organizing and
setting up libraries.

Parameter Boxes show the
parameters assigned to Hot
Fader control. These behave
exactly like the Edit window
parameters; click to bring up a
fader for adjustment.

The current frame rate is
displayed here.

Time code is displayed in this area. NuVerb uses
MIDI time code for locking. SMPTE time code may
be used as the source by being converted to MIDI
time code through the use of an external converter
device. Many of the larger MIDI interfaces provide
this function.

The indicator light to the immediate
left of “MIDI Time Lock” lights to
indicate that NuVerb has locked to
External MIDI time code source.
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Open NuVerb
To open NuVerb, double click on the NuVerb program Icon.

When opened, NuVerb creates a default library of programs and opens a Program Library
window on your screen. If this does not happen select Create Default Library from the
Options menu. The default library opens with Large Hall selected.

Load a Program, change a Hot Palette parameter
Click on the Load Program button (or double-click on a Program name) to load it. Select a
parameter on the Hot Palette, then click on the selected parameter to pop up a fader  for
adjustment of parameter value.

Click on the Library window Load Program button and observe the Hot Palette. Note that
Large Hall appears as the “Current Program”. Play your audio source to confirm that Large
Hall is loaded. The Hot Palette contains five parameter boxes. These can be assigned to any
parameter, but have been preset to those shown for the purposes of these tutorials.

Click and hold on the Hot Page SIZE parameter. A
fader appears just as in the Program Editor. As you
adjust the fader value, you should hear the room size
change. Try the other controls.
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Editing Hot Palette Parameters
From the Program Editor, click on the Fader/MIDI Cntl  button to open a dialog box for Hot
Palette control assignments.

Now, let’s look at how program faders are assigned to parameters. Select any program in your
library. (Don’t select Large Hall, as we’ve already assigned Hot Palette parameters for you in
that program.). Open the Program Editor for the program you’ve selected. Click on the Fader/
MIDI Cntl  button in the Program Editor control panel to open a  Hot Fader Editor dialog.

Note the radio buttons at the bottom of the Hot Fader Editor. The selection you make here will
determine which parameters are available as menu choices under Parameter. For now, make
sure that Program is selected.

Click here to open a menu of parameters
available for assignment to the Hot Page.

Radio buttons allow you to choose which pa-
rameters appear in the  menu. Select Program
to assign parameters from the Program Over-
view. Select Effect A or Effect B (when avail-
able) to assign parameters from the Program
Editor Effect view(s). Select Hot Fader to
assign a  Hot Palette fader to a MIDI controller.
(See MIDI Control.)
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Click on the first display under the label Parameter. A pop-up menu appears, allowing
selection among the available program parameters. Select Wet-Dry Mix and assign it by
releasing the fader. Now that you have selected a parameter for control, a row of selectable
assignment boxes should appear.

Selecting a parameter for
control here...

...displays this line of assignment choices

Next, select a control source for the Wet-Dry Mix parameter  by clicking on the assignment box
labeled Source, and selecting “Fader 1.” This assigns the first parameter box on the Hot Page,
and its fader will now control the output mix of this program.

Click OK and return to the Program Editor. Note that the first parameter box on the HotPalette
is now labeled OutMix. Click on this box to pop up a fader, then make adjustments to the value.
Notice that the value displayed in the Program Editor moves as the Hot Fader is moved.

Let's go back to the Fader/MIDI Cntl window and examine the action of some of the other
controls.

To the right of the Source selection are the source Min(imum) and Max(imum) values. These
allow you to select any portion of the source controller's full range to be used for control. These
are selected and controlled by a pop up fader, exactly as the source field. Any value from 0-127
can be assigned to either field, making inverse control possible.
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The next set of Min and Max controls adjust the range of the selected parameter available for
the source to control. As an example, this might be used to give a MIDI controller fine control
of a value range, where a range of 1000ms is available for predelay, and you are only interested
in fine control from 1ms-150ms. To do this, set Min to 1ms, and Max to 150ms. Set your source
Min and Max controls to 0 and 127, respectively. This would give you fine control of all
predelay values between 1ms and 150ms.

The Value display on the far right shows the current value of the control and its setting on
program load. To change this value, select it from the Program Editor.

Multi-parameter and Inverse Fader/MIDI Control
Hot Palette faders can be configured to control multiple parameters. They can also be
configured to provide “inverse control.”

Hot Palette faders can be configured to control more than one parameter. To see how this is
done, select the Radio button labeled Effect A.

 Now, select the next Parameter display (just below the one we’ve assigned to Out Mix), and
select RTIME. Assign Fader 2 as the source controller. In the next Param display, select PDLY
and assign “Fader 2” as the source controller for it as well. Now, when this fader is moved, you
will be simultaneously controlling both Reverb Time and Predelay.

Hot Palette parameters can also be configured for inverse control, i.e. the parameter value is
reduced as a fader is moved upward  (and vice-versa). To illustrate this, click on the assignment
box labeled “MIN” for the RTIME parameter. Set the value to 127. Select “MAX” and set its
value to 0. Now, when fader 2 on the Hot Palette is moved to its lowest position, you will get
the maximum reverb time, and reverb time will be decreased as the fader is moved upward.

Let’s listen... Select OK to exit the Hot Fader Editor dialog. Note that the second Hot Palette
parameter box is now labeled Multiple and moving its fader will control both RTIME (with
negative scaling) and PDLY.  Start your audio source and play with the faders to confirm this.
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MIDI Controllers and the Hot Palette
MIDI controllers can be assigned to parameters  with the same method used to assign fader
control.

To assign a MIDI controller to a parameter, you will need a keyboard (or any device that
generates MIDI controllers), and a MIDI interface for your computer. For the purposes of this
tutorial, we’ll assume that you are using a MIDI keyboard.

Connect your MIDI keyboard to the computer via your MIDI interface. Start NuVerb, select a
program, and open its Program Editor. Click on the Fader/MIDI Cntl button on the Control
panel to open the Hot Fader Editor dialog.

Click on the first Param display, and select Wet-Dry Mix. Assign “Mod Wh” as the Source.
Now, your keyboard Mod wheel will control the output mix of this program. Check to see what
MIDI channel your keyboard is transmitting on, and assign the same channel number under
“Chan.” Click on OK to exit the Hot Fader Editor dialog.  MIDI channel (including OMNI) is
also adjustable with a pop up fader. Click on "Chan."

MIDI Program Change and Control Data are displayed here for reference only. These
selections can be changed by selecting MIDI Setup in the Options menu.

Move the keyboard Mod wheel and watch the program’s OutMix  value change. As with Hot
Palette faders, MIDI controllers can employ negative scaling, and control multiple parameters
on more than one NuVerb card. Hot Faders are also available for MIDI control. This allows you
to select a single parameter or a group of parameters for control by the on-screen fader, and also
remotely control the fader via MIDI.
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Viewing Fader Assignments
The Fader Data button on the Program Editor control panel shows current Hot Palette fader
assignments.

When a Hot Fader is assigned to more than one parameter, its Hot Palette label changes to
Multi. If you forget which parameters are assigned to it, you can click on the Fader Data  button
to find out. This button also provides a useful check when using multiple NuVerb cards, as
each Hot Fader will control all parameters assigned to that fader  on all assigned cards. To view
your Hot Fader assignments, click on the Hot Palette  Fader Data button.

An information window will appear, showing data for the first fader. Click anywhere to scroll
to the next fader entry. Continue clicking through the list — your sixth click will exit the
window.

Click here to view fader
assignment data.

Details of Fader 1 assignment appear
in a window. Click again to view data
for Fader 2.

Once you have clicked five times
(once for each fader) click to exit the
fader data window.
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Saving Hot Palette Parameter Changes
Changes made from the Fader/MIDI Control window can be saved by selecting Snapshot
from the Edit menu.

After a program is loaded from a library, you can make changes to the program "live" via the
Hot Faders, or via MIDI. Having made changes, you may want to save this new version of the
program. To do this, first make sure that the program you are using is in a library assigned to
the Hot Palette, then select Snapshot from the Edit menu. This places a copy of the current
version of the program at the end of the library. This new version will have the same name as
the original, so we recommend that you open the Program Editor to rename it. Of course, this
new program can now be cut/copied and pasted anywhere in this, or in any other library.

The Hot Palette and Multiple NuVerb Cards
On opening a program, the Hot Palette is immediately assigned to the first NuVerb card in your
system. This appears as "Slot #" on the Hot Palette Control Panel. If you have multiple NuVerb
cards, you may want to change the Hot Palette slot assignment to get a quick look at what
programs are running on other cards. (If you have no NuVerb card installed, the Hot Palette
will come up unassigned.)

An On Line/Off Line toggle button is provided on the Control Panel to allow you to use
NuVerb as a software-only application to edit libraries.
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Tutorial 3: NuVerb and MIDI
NuVerb’s MIDI implementation suggests many exciting possibilities for controlling and
shaping the sound.  Multiple parameters can be controlled with a single MIDI controller, or Hot
Fader. Multiple cards can be controlled simultaneously. Parameters can be “inverse mapped”
so that, from the same control, one increases in value another decreases.

NuVerb's MIDI setup is tied to your NuVerb card, not to a library. This makes it easy to change
libraries without a lot of setup work. You need to define the MIDI control setup for each
NuVerb card in your system. This requires identifying the MIDI operating system you are
using,  the MIDI device you are using for control, and the MIDI Channel for each NuVerb card.

Before we get into examples of how to create these setups, let’s look at configuring NuVerb to
work with your MIDI system, and get familiar with the windows we will be using.
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Selecting the MIDI Operating System
Select MIDI Manager and/or OMS under Preferences in the Edit menu.

The MIDI operating system you use with NuVerb (MIDI Manager and/or OMS) must be
selected under Preferences  from the Edit  menu.  Once you have selected one of these
operating systems, and clicked on OK, you will be asked to quit and restart NuVerb.

With two MIDI interfaces, it is possible to use both MIDI Manager and OMS  at the same time.
If you are doing this, refer carefully to the instructions from the manufacturer of the MIDI
interface, and make sure each is using a different serial port: one on the printer port, and one
on the modem port.

Click to select either, or both,
MIDI operating systems.

Click on MIDI Reset  to remove
OMS device IDs which are no longer
in your system. After resetting,
reconfigure your MIDI setup.

Once you've made your selections,
click OK and restart NuVerb.
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The MIDI Setup Window
The MIDI Setup window is used to select the MIDI drivers/devices that NuVerb will
recognize. Below is an example of this window. Familiarize yourself with its parts and
functions.

First, click here to open a menu which
allows you to choose which slot is being
configured for MIDI. The default selection
is the first NuVerb card in your system.

When OMS is selected from the
Preferences menu, this button is
available to open OMS Studio
Setup and make changes to the
OMS Setup.

Click here to enable
recognition of MIDI Program
Change mesages on all MIDI
channels selected for this
port.

Click here to update the selected MIDI
setup without closing the window. This
allows  you to confirm the MIDI connections
that have been made.

Click on these boxes to enable
MIDI Channels. Click again to
disable recognition of MIDI
messages on that channel.

Launch OMS

Once you have made port
assignments, clicking on any
of  these eight fields will pop
up a menu for selection among
the MIDI devices you've
defined for your system (via
Patchbay and/or Studio
Setup).

Next, click on a port assignment
box to open a menu which allows
you to choose a data port for the
selected setup.
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Working with MIDI
Select a MIDI Driver
MIDI drivers are selected under Preferences in the Edit menu. Select Apple MIDI
Manager, Opcode OMS, or both.

In order to work with MIDI, you must first enable MIDI Manager and/or OMS. Select
Preferences from the Edit  menu and make your selection. Once you have made your sleection
and clicked OK, you will be instructed to re-start NuVerb. Click OK, quit, and restart NuVerb.

Note: If both MIDI Manager and OMS are used, you will want to use two MIDI interfaces — one for each driver.
Each interface will require the use of one Macintosh serial port (printer or modem).  Refer to the
manufacturer's instructions included with the interface.

The MIDI Setup Window
Once you have rebooted NuVerb with your MIDI driver selections, the MIDI menu items
under Options  —  MIDI Setup ... (Command M) and Open MIDI Input Window (Command
I)  will be enabled.

Open MIDI Input Window (Command I)  opens a status window where you can verify the
current status of your MIDI configuration.

MIDI Setup ... (Command M) opens the MIDI Setup window shown on the previous page.

Open the MIDI Setup window.
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Select a NuVerb Card
NuVerb automatically selects the first card in your system. If you have more than one
NuVerb card, click on the Slot assignment box in the MIDI Setup window to select the
location of the NuVerb card you want to configure.

Each NuVerb card in your system is identified by a Slot number. To specify which card you
want to configure, click on the Slot assignment area of the MIDI Setup window to pop up a
menu of slot numbers.  The default selection is the first card in your system.

Click here to pop up a menu
for slot selection.

Note: You can have as many NuVerb cards in your Macintosh as you have NuBus slots. (This will vary
with Macintosh type.)  A NuBus expansion chassis increases the number of slots available to
your Mac. Digidesign manufactures an expansion chassis which is certified by Lexicon for use
with NuVerb. (For information, contact either Lexicon or Digidesign)
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Assign a MIDI port
Click on a port assignment box and select a port for MIDI data input.  Eight ports are
provided to accomodate the eight inputs supported by OMS, and to allow simultaneous use
of MIDI Manager.

NuVerb provides eight ports for incoming MIDI data for each NuVerb Card. Eight MIDI
Manager, and eight OMS ports are provided.  One (and only one) MIDI device can be assigned
to each port. If a port has a device assigned, it appears wherever that port is selected. When a
device assigned to a port is changed, all other places that port is used are affected. The
maximum number of devices allowed is sixteen: eight on the MIDI Manager ports, and eight
on the OMS ports.

Click here to pop up a menu
for port assignment.
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MIDI Source Assignment
Click on a device assignment box to pop up a menu of MIDI devices available for
assignment.

The next step is to select the MIDI Device for each assigned port.  The MIDI devices available
fall into two types: OMS type devices and MIDI Manager type devices.

All the OMS devices that are defined in your OMS Studio Setup appear in a popup menu when
you click on the device setup menu. Select one by highlighting it with the mouse.  If you would
like to control NuVerb with more than one OMS device, enable OMS on an additional port, set
MIDI channel and program change options, and select the additional device.  Select one device
per NuVerb port (as many as eight )

The Macintosh serial ports (printer and modem) that you have enabled using MIDI Manager
appear here, along with other software which addresses the MIDI Manager, such as sequencer
programs, and drivers for MIDI interfaces. These ports are enabled using the Patchbay™  desk
accessory  in the Apple menu. Select the desired MIDI Manager device from the pop up menu.

Note: NuVerb works with MIDI Manager drivers from Opcode and Mark of the Unicorn, as well as with Apple

MIDI Manager. Contact the manufacturer  for driver-specific information, as each has different options.

Click here to pop up a menu for device
assignment  for each port enabled.

The menu shows the devices you have
enabled using OMS Studio Setup or
MIDI Manager Patchbay.
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Selecting MIDI Channel and Accepting Program Change Messages
Click on the box beneath a port assignment to enable recognition of MIDI Program Change
messages. Click on the channel assignment box(es) beneath the device assigned to that port
to enable recognition of MIDI data on the selected channel(s).

NuVerb allows you to filter out MIDI information by specifying the MIDI channels on which
you want to receive information. Click MIDI Channel assignment box to enable the MIDI
channel.  Click again to disable the channel assignment.

Clicking on the port assignment box labeled "Accept Program Changes" to enable MIDI
Program Change messages to be recognized on all MIDI channels selected for that port.

Click on one or more of these boxes
to  enable recognition of MIDI data
on the corresponding channel(s).

Click here to enable
recognition of MIDI Program
Change messages on the
assigned channel(s).
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The Launch OMS Button
Click on Launch OMS to make quick changes in your OMS setup. (This button is only
available if you have selected OMS under Preferences.)

For those using Opcode OMS, this button launches the OMS application so that you can make
quck changes in the configuration of your OMS  Studio setup.  After making changes, you must
quit the OMS application before returning to NuVerb.  If you do not quit the application before
returning to NuVerb, your changes may not be updated within NuVerb. When devices are
removed from you MIDI setup, you must use select Preferences from the File menu and press
MIDI Reset.

The Update Button
Click on Update to update MIDI configuration changes without leaving the MIDI Setup
window.

Clicking on the  Update button allows you to update  changes made to your MIDI configura-
tion within the MIDI Setup window. If  you have opened the MIDI Manager Patch Bay or the
OMS Studio Setup to make change there, pressing Update  updates those changes in NuVerb.
This allows you to send ProgramChange messages, and “move” controllers to verify that they
are working correctly without leaving the window.

Note that the OK button, which allows you to exit the MIDI Setup window, also updates any
changes made to the MIDI configuration.  When leaving the window, it is not necessary to hit
Update in addition to OK.
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Tutorial 4: Automation
NuVerb's Automation list  provides an unprecedented degree of effects control in a suprisingly
easy interface.  The Automation list is opened from the Windows menu, and can be configured
under Preferences to automatically open when the program is booted.  Basically, you input
MIDI time code, put the list into record and click on programs to load them and move the faders
to adjust the parameters — all the same things you’ve already been doing.  An FX Automa-
tion™ list is freestanding, and does not need any libraries to run. This makes automation easier
in NuVerb than in sequencer-based automation.
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The Automation List Window

Click here to enable the Automation list.
Note: you must supply MIDI Time code
to synchronize the list and provide a
timing source.

Click here to add a comment line
at the current timecode entry.

When active, click here to
open an Edit window for the
selected program.

Keyboard Shortcuts
Record ctrl R

Play ctrl P
Editor ctrl E

Capture ctrl C
Add Comment ctrl A

Offset ctrl O

Click here to select a smaller window for
monitoring. (The monitor view has a button
in this location labeled Editor which returns
you to this view.

Click here to enable the
list for playback.

When active, click here to
load the selected program
making it the current program
on the selected Nuverb card.
If the Hot Page is looking at
the same NuVerb card, the
Current Program display on
the Hot Page will display the
program name.

Click here to open a dialog box
allowing  offset of the selected
list item(s) by adding or sub-
tracting Time Code to their
current values.

Select any  list event's start-
ing timecode display, and
click here to replace it with
current timecode as dis-
played on the Hot Palette.
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Program and parameter changes are recorded as Automation List events. Create a program
change event by clicking on the  Record button, starting the timecode source, and clicking on
programs in an active library. Once a program is entered into the list, parameters can be entered
in one of three ways: via Hot Fader adjustment, via MIDI, or by changing parameters In the
Program Editor. List events appear as shown below.

Iterations

Initial value

Final value

Program or
parameter name

NuVerb card
location

Type of event

Entry time Duration

Active entry
indicators;
option click to
disable/enable.
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Recording an Automation List
Let’s try recording and playing back a simple “pass” of Automation.  We’ll need:

• An audio source

• A source of MIDI timecode (locked to the audio source)

Connect the MIDI timecode source to NuVerb through our MIDI interface using the MIDI
Manager Patchbay™. (Questions? See Time Code Aplications and About Midi Manager in the
Reference section.)

Make sure Ignore Incoming Timecode under the Options menu is not selected.  If it is, de-
select it.

Make sure that the library you want to use, and the Hot Palette are both  assigned to the same
slot#/NuVerb card.

Once audio source and Timecode connections are  made, we can create a list.

1. Click on the Record button on the Automation List control panel.

2. Start playing  your Audio/timecode source.

3. Select a program in your Library and load it (by clicking on the Load button, or by double-
clicking on the program name).  You will see the program appear as an entry on the
Automation List.

4. Click on the first Hot Palette parameter, and adjust its value with the fader. When the fader
is put away, you will see new events which  represent the parameter adjustments you just
made drop into the list.

5. Click on Record to stop recording, and to rewind the audio/timecode source.

Remember — when you open the Program Editor in Automation, you are using it as a control
surface. If you want to leave the program in its original condition, select Don't Save  when
closing the window.
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Now, you have a simple event list.  You can, of course, record more moves, more parameter
changes, and longer sequences using this basic procedure.  Automation data to multiple cards
can be simultaneously recorded using external MIDI controllers for control of multiple cards.

Playback
Click on the Play  button to start playback of the list.

Click on the Automation List Play button to enable the list, and start the audio/timecode
source. You will hear the changes made and see the list change to indicate the events played.

Note that when an EDL is recorded using one time code frame rate, then played back at a
different frame rate, NuVerb recalculates the position of the events to maintain their relation-
ship to the picture or other material used for synchronization. The Hot Palette display will
change to reflect incoming time code, as will the display in the Options menu. Note that the
speed difference between 29.97 and 30 is not supported in MIDI, and that all calculations of
frame position in NuVerb take into account only frame count.

Saving an Automation List
Select Save from the File menu to bring up a dialog box that allows you to name your list
and file it.

The programs necessary to play back the list are stored with the list. This makes the list “free
standing” and not dependent on any of the libraries from which you may have selected the
original programs. Select Save from the File menu to bring up a dialog box that allows you to
name and file your list.

Go ahead and save the list we just created.  Make sure it is not Play-enabled, and click the close
box in the upper left hand corner to close the list.
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Editing Commands
Before we begin editing, let’s take a look at the techniques used for editing lists, including
selection and manipulation of events.

Single Event
Click on any event entry to select it for editing.

Contiguous Events
Hold down the shift key, and click and drag to select a group of adjacent events.

Discontiguous  Events
Add discontiguous events to your selection by clicking on an event entry while holding
down the Command key.

Removing a highlighted item from the group of selected events.
Hold down the Command key and click on the event entry you want removed from the
group.

Click and drag to select a
number of adjacent entries
for cutting, or copying.

Hold down the Command key
while clicking on an event to add
it to a non-adjacent group.

Hold down the Command key
while clicking on a selected
event to remove it from a group.



LexiconLearning to Use NuVerb

50

50

Now, let’s take a look at the Automation editing commands.

Editing Commands found in the  Edit menu
Cut
This command removes any selected event(s) from your list. (Cut items are temporarily saved.
A paste command will insert these in a new location. Another cut or copy command will erase
them and replace them with new temporaily stored items.)

Copy
This command copies any selected event(s) from your list — leaving your list intact. Copied
items are temporaily saved, and will replace any other temporarily stored items temporarily
cut or copied.

Clear
This command deletes any selected event(s).

Paste At
This command calls up a dialog box which allows you to enter a numerical location for
insertion of the selected item(s).  If more than one item is being pasted, the first event in the
group will appear at this number.  This is sometimes referred to as “head sync”.

Editing via the Automation window Control Panel
Offset
This command appears as a button at the bottom of the FX Automation™  window. Clicking
on  it calls up a dialog box which allows you to add to or subtract from the starting time of the
selected event(s).  All of the selected events will be moved by the amount you type in here.

Note that selecting Add will make the selected events appear later in the program;  selecting
Subtract will make the selected events appear earlier in the program.
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Changing the values of list events
To change the value of a list  event, press option   while clicking on the value.  This will display
a fader for value adjustment.

Changing Start Time and Duration of an Event
Press option   while clicking on the event start time or duration.  The number will be highlighted,
indicating that the value can be trimmed.

Note that, when typing a  number,  digits are entered from right to left. This makes trimming
convenient.  If, for example, the start time is 01:00:40:26 and you want the event to start at
01:00:40:05,  you only have to type  05, and then press enter.  It’s that easy!  The same applies
to trimming the duration.

Changing Slots
The slot, or NuVerb card, on which an event occurs can also be changed. Press option   while
clicking on the  Slot number to display a  menu of slot selections.

WARNING
Use with caution. Changing the slot assignment of a Program Change event will change all of the
parameters with that slot number from that point to the next Program Change event in the list.
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Editing an Automation List
Let’s go ahead and do some editing on the list you made in the previous section.

• Open your list. To do this, select Open from the File menu. Among the listings, you should
see the list we just created.  When you select it, it will open in  the smaller “Monitor” view.

• Click on any program to select it.

• Copy , then Paste  using the standard Macintosh techniques.

• Enter the time code location where you want this program to start, then click OK. A copy
of the program will be pasted into the list at the time code location you have selected.

(Using Cut and Paste is identical, except that the original you select is removed from the list
and  pasted into the new location.)

Trimming
Hold option and click on the start time or duration value field. Typed in values are entered
from right to left.

To select either the start time or the duration of list entries, hold option   while clicking on the
number.  Once the number is selected, just type in the amount  you want to change.  For
example,  if the start time is  01:00:12:26, and you want to make it 10 frames earlier, you only
have to type "10" (the number of frames), not the whole number.

If you want to type in a new location that is less than the current location you must type a
complete timecode entry, including any leading zeros. This is also true for entering offsets.

Type in a new timecode entry.
Digits will be entered from right to
left.

Hold option and click on the start-
ing time to select the field.
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Offsets
Click on the Offset button to open a dialog box allowing you to enter offset amounts.

Click on the Offset  button at the bottom of the FX Automation™  window to call  up a dialog
box that allows you to add to or subtract from the starting time of the selected event(s).  All of
the selected events will be moved by the amount you type in here.  Selecting "Add" will make
the selected events appear later in the program; selecting "Subtract" will make the selected
events appear earlier in the program.

Highlight one or more entries in the list and experiment with them to get a feel for where the
offset command will move them.

WARNING:  It is possible, using Paste, Offset, and trimming, to move parameters into
places in the list that contain programs that do not use them!  Be careful to keep track of
which program they belong with.  We give you the flexibility... be creative, but be careful!

Changing Parameter values
Hold down option and click on any of the three parameter value fields (start value,
iterations, or final value) to pop up a fader for value adjustment.

There are three  parameter value fields: one for  the start value, one for iterations, and one for
final  value.  When the list is played, and each event is highlighted, you will see the start value
field  move to the final  value field.  This animation provides visual verification of the change.
To alter any value field, press option  and click  on the field to pop up fader.

The iterations value is the maximum number of values available for the parameter during the
duration of the event.  This value is dependent on the frequency with which  the Macintosh is
able to sample a fader.  Using Smooth, all changes are linear, played back with millisecond
accuracy.  When Smooth is turned off, the boundary is 128 values ( as often as the Mac can get
them). Adjusting the iterations to a lower value will make the change less smooth, which may
be desirable.  A lower  iteration setting is also recommended when the Macintosh is very busy.
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Editing the program in the list
Click on the Program Edit button with a program name on the Automation List selected, or
double click on any unselected Automation list program name to open the Program Editor.

To change the program loaded in the list, either highlight the program change in the list and
then select the Edit Program button, or double click on the programto open the Program Editor.
When the window is closed you will be prompted to save. Selecting Save will place the
program into the automation list.  Changes made will not affect the library the program was
taken from.

Comments
Click on the Comment button to insert a text area into the list. Hold down the option key and
click to the right of the label to open a text field. Type in your comments, then click anywhere
outside the comment area to close the comment field.

Comment lines are entered into the list by pressing the Comment button.  This can be done
record enabled while moving or stopped. To enter text into a comment field, hold option  and
click  to the right of the word "Comment." Type whatever you like, then click elsewhere in the
list to close the comment field.

Click on the Comment button to add a line for text entry.
Hold down the option key and click to the right of the word
"Comment" in the text line to open the text field.

Click anywhere off the comment
area to stop adding comments.
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More on Recording Lists
Recording from MIDI
MIDI can be used for automation.  Simply select a program and assign MIDI controllers to the
parameters you want to control. When recording a list, parameters remotely controlled via
MIDI go right into the list, as do program changes.

Recording from a Program Editor
Any Program Editor can be opened, and any parameter directly adjusted.  This is useful when
you want to adjust a parameter on the fly , but have not  selected that parameter for control via
the Hot Faders or via MIDI.

Recording while Stopped
Recording a program change into the list is possible while list is stopped at a Time Code
number.  Note, however, that recording parameter changes this way is not recommended.

Recording Multiple parameters
Multiple parameters can be simultaneously recorded into the list  by grouping them for control
from a Hot Fader or a MIDI controller. Different levels of change, from this single grouped
control, may be done by setting up the scaling on each control. (See MIDI Control.)
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Automation lists and timing accuracy
The timing accuracy of entry into the Automation list is dependent on the clock speed of your
Mac, other programs you are running at the time (how busy your Mac is), and the method of
entry  you choose.  The timing accuracy of effect changes is inherently "softer" than the
placement of sound sources. Nevertheless, there will be times when the accuracy of  changes
is critical. Let's look at the factors governing this and some of the techniques available in
NuVerb to achieve your goals.

• Clock Speed — The faster the clock speed of your Macintosh,  the more accurate the  timing
of entries.

• Programs running at the time — The more things your Macintosh  is trying to do, the
slower the updates to the list will be.

• Entry method — The fastest method is MIDI entry of program and parameter changes.
This is followed is speed by on-screen use of the Hot Faders for parameter changes, then
by  library entry of program changes. While using the Program Editor to enter parameter
changes is the most immediate, putting all parameters at your finger tips, it is also the
slowest.

Making timing adjustments
Timing adjustments are easy to make, whether they involve trimming the start time, or
offsetting a range of moves. (See Editing an Automation List.)  These two methods offer local or
global methods of refining the timing of moves and are a powerful feature of FX Automation.™
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Program Changes
Many of the things you used to have to change programs to do can now be achieved by
changing multiple parameters in the same program!

NuVerb offers some new ways of dealing with the age old problem of loss of audio between
program changes.  Using the “dual machine” Cascade programs, the output level control of
Effect A and Effect B can be assigned to a Hot Fader or a MIDI Controller with their respective
MIDI controls set in opposition. This causes one program to fade out while the other fades in,
all controlled from one fader.  The obvious example is two different types of reverb, but you
can work with any of the Cascade programs.

The Single programs are large programs that use both of NuVerb’s internal processors as a
single unified engine.  When a program change happens, both processors must be loaded with
new information. This happens quickly, but it does take time.  If you want to make changes
using Single programs, remember to take advantage of parameter changes.  Often, doing this
is all that  is needed.  Experiment!

List overload
There are times when your Macintosh  may be very busy, and your list very full.  At times like
this, it is important to understand that NuVerb will always try to execute all list moves with
1/2 frame accuracy. If the system becomes overloaded, the program has been designed to skip
moves in order to preserve time flow and prevent freezing or bogging down.
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Tutorial 5: Working with Other Systems
NuVerb is compatible with a variety of software packages.  In fact,  many leading manufactur-
ers of both hard disk recording systems and sequencers are NuVerb Development Partners.
This reflects a commitment to work with Lexicon to achieve and maintain NuVerb compatibil-
ity  with their software currently on the market.

Hardware Considerations
Your first consideration when running NuVerb with other systems is the amount of available
RAM in your computer. NuVerb requires at least 8 megabytes of RAM. The application itself
uses only 4 megabytes, but the Macintosh operating system also requires memory. Any
software you run along with NuVerb will have additional memory requirements. Refer to the
manufacturer’s specifications.

For example, Digidesign specifies that ProTools (4 tracks) will run with 8 megabytes of RAM.
Likewise, Lexicon specifies that NuVerb will run with 8 megabytes of RAM. In both cases,
allowances are being made for memory requirements of Macintosh system software, so the
amount of memory actually required to run both NuVerb and ProTools is probably closer to 12
megabytes than 16 megabytes.   Both of us, however, would probably recommend you get the
16 megabytes, as there is really no point in skimping on RAM.

Faster is better. After memory, the next consideration when running NuVerb with other
software is the speed of the central processing unit of your computer.  Although speed is
important, note that accelerator boards are notorious for creating software conflicts. If you are
planning on an accelerator board as a cost effective way to upgrade the power of your current
computer, make sure you can return the board if it causes problems with your applications.

The behavior of NuVerb screens and faders is affected by the speed of your Macintosh. Note
that black and white monitors tend to run the NuVerb graphic interface faster than color
monitors. If you have a slower computer and/or a demanding application, you may want to
run NuVerb in black and white.
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Connection
NuVerb uses AES to send and receive audio.  Any system capable of  sending or receiving an
AES signal can theoretically interface with with NuVerb. This might occur in a variety of
system configurations:

• A desktop production system that provides digital mixing, such as Pro Tools

• A system using a desktop disk audio card as a source, and a DAT deck for recording/
monitoring, with NuVerb inserted between the two for mastering

• A system incorporating a digital mixer (with NuVerb on an auxilary send, and the output
returned to an effects return

• A system using an outboard A to D/D to A converter. This makes the NuVerb fully
functional in the analog world with conventional analog mixers.

Most of the larger hard disk recorders have digital outputs. These can be used in a variety of
ways. If the system has internal digital busing, the output may be able to be configured as an
auxilary send on a traditional mixing console, with the NuVerb output being returned to the
device to be recorded or monitored only.

Some systems, large and small, do not provide a digital send, and their output is analog to
conventional analog consoles.  In such cases, using an outboard A to D/D to A converter
integrates NuVerb with the analog mixer.

Software Considerations
As mentioned earlier,  Lexicon is committed to maintaining compatability with widely
available software in both the disk recording and the sequencer markets. Find out if the
manufacturer of your software is a NuVerb Development Partner.  In certain cases, as with
ProTools, a certain software revision may be required.
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MIDI
MIDI can be used to control NuVerb program parameters.  In addition, NuVerb uses MIDI
Time Code (MTC) for FX Automation™ timing and synchronization.

NuVerb is compatable with Apple MIDI Manager, Opcode OMS, and Mark of the Unicorn
MIDI Manager Driver. You must verify that one of these are able to “find” your MIDI interface.
NuVerb will appear as a device that receives MIDI. NuVerb does not transmit MIDI. Refer to
the instructions provided with your interface by its manufacturer.

Applications
NuVerb can be used in a number of applications during the production process. A few
examples:

• On an individual instrument while recording the track.

• To process and re-record a track. This allows a very specialized use of NuVerb to create
some suprising effects on an individual track, while making NuVerb avaliable for more
general applications on mutiple tracks during the mix.

• As a general processor in the mix, providing, for example, world-class reverb.

• As a mastering tool, using programs like PONS, Stereo Adjust and the Digital Compressor.
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Example: Connection to a Digidesign ProTools System

Pro Tools Setup
Hardware

1. Connect NuVerb via AES to ProTools Digital IN.

2. Connect the audio monitors to analog outputs 3 and 4.  (1 and 2 are going to be used as
sends/returns to and from NuVerb.)  Note that ProTools allows using either the digital
inputs and outputs or the  analog inputs and outputs 1 and 2.

3. If using the expansion chassis, observe the card ordering specified by Digidesign:  system
accelerator (SCSI Card), ProTools cards, sample cell cards, NuVerb.

Software

Before you start, make sure you are running ProTools version 2.03  or higher.

1. Start the ProTools application.  Open a session, for example, the  demo session.

2. Configure the outputs to use 3 and 4 OUT.

3. From the Setups menu:

Under Hardware…, select AES/EBU format, and Digital for CH 1,2 inputs.

When you are done, note that the “Sync Mode” will change to “Digital.” — You must
change the sync mode to “Internal.”  Click OK.

Under Return Routing…, select  inputs 1-2 as returns, and press the  radio button selecting
“route to output 3-4.” Click OK.

4. In the Display  menu, select  Show Sends  and  Show Mix Window.

Send 1 and  2  controls are now configured as a pre-fader send to NuVerb.  The return from
the NuVerb ( set in step 3) is to analog outputs 3 and 4.  Note that Pro Tools does not provide
controls for return level, but this can be set in NuVerb.
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8. From the ProTools Options  menu, select Play in Background. This allows ProTools to play
audio while NuVerb is running (in the foreground).

9. From theProTools Display menu, select Show Mix Window. Turn up the send controls at
the top of this window.

10. Now, open NuVerb, create a default library, and select a NuVerb program.

11. Return to ProTools and select Play.  You may get a message box saying, “The Modem Port
is in use now, and cannot be used by this application.” Ignore this message, click OK and
proceed.

Other Considerations

1. If you want to use MIDI, make sure there are no conflicts between NuVerb and ProTools
in your serial port selection . Either have one of the two use the printer port and the other
use the modem port, or turn off the serial ports in ProTools.

2. Neither ProTools nor NuVerb like Apple Talk, so disable Apple Talk while using these
applications.
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3
Reference

Summary of Keyboard Shortcuts

In the Edit Window:
tab steps through displayed parameters
enter toggles fader display
Command ↓ selects a more detailed view
Command ↑ selects a more general view
Command →  moves from Effect A to Effect B
Command ←  moves from Effect A to Effect B

In the Automation List  Window:
ctrl R toggles record enable/disable
ctrl P toggles play enable/disable
ctrl E toggles edit and monitor views
ctrl C captures incoming timecode and enters

it in place of selected start timecode
ctrl A opens a text line at current timecode entry
ctrl O calls dialog box for entry of offset amount

With the Fader:
↑   ↓ adjust parameter value
home sets fader to its minimum value
end sets fader to its maximum value
page up moves fader up with coarse control
page down moves fader down with coarse control
option ↑ moves fader up with fine control
option ↓ moves fader down with fine control

In the Menus:
File
Command N opens new library
Command O calls dialog box for opening files, folders and

 applications
Command W closes active window
Command S saves changes to library or event list
Command Q quits current application

Edit
Command X cuts selected text or graphics
Command C copies selected text or graphics
Command V In libraries, inserts contents of clipboard

above selection; if no selection, inserts at end
of list. In Automation, calls a dialog box for
timecode entry

Command B deletes selected text or graphics

Options
Command L opens default library
Command T toggles recognition of incoming timecode
Command G toggles  Macintosh internal timer on/off

Windows
Command F toggles display of Hot Palette
Command E toggles display of Automation List window
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NuVerb Screen Graphics
Window Controls

General Information
Most windows consist of an active viewing and entry portion with a series of buttons in a
control panel at the bottom of the window. In general, clicking on a button will activate it, and
activated buttons will appear as shaded.

Text entry, where appropriate, as in program naming, etc. behaves in a standard Macintosh
fashion, with insertion point/keyboard text entry.

Nuverb graphics allow dynamic changes to overall program parameters. Expanded views of
the effect(s) running in a program are available from the Program Editor control panel, or by
clicking on labeled non parameter-type boxes.
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Program Library Window
Under Options in the menu, select Create Default Library to open the Program Library
Window.

Clicking here selects between
these two views

The expanded view  shows the effects loaded
into each program. EA = Effect loaded into
Machine A; EB = Effect loaded into Machine B

Program names are preceded by
a code (SG, DM, or CC) indicating
program type:Single, Dual Mono,
or Cascade.

 Click on any program name to
select it. Double click to load the
program and open a Program
Editor.

Click here to load the
selected program.

Click here to open the
Program Editor  for the
selected program.

Displays the NuVerb card which is currently
selected. Click to open a dialog box which
allows selection of another NuVerb card.
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Program Editor
The view/entry area of the Program Editor shows a diagrammatic representation of the
program. Each program has as many as two additional views, enabling you to “zoom in” on
the details of the effect(s) in any program. A panel of buttons beneath the viewing area provides
easy access to other views and other control windows.

Within the viewing area, clicking on any parameter will select it. Clicking on a selected
parameter (or double clicking on an unselected parameter) will open a graphic fader which can
be used to adjust the parameter over its entire range of values. (See Fader.) In the control panel,
shaded buttons are active.

Parameter boxes show the current
value of labeled parameters. Click
on any parameter box to select it;
click and hold to pop up a fader.

Click to access a deeper level of effect
control.
Note that, in programs designated as “Single”, only
one effect (Effect A)  is available. Effect B controls
are available in programs with two effects

From any other view, click here
to return to this overview.

In some effects, clicking here
will display a third level of detail.

Program identification information is provided along the bottom of
the control panel. Names here can be altered by dragging the cursor
over the name label to select it, then typing a new name.

Resets all parameters
to the last-saved state.

Click here to load the original
program.

Opens a dialog box allowing external
MIDI controls or program faders to be
assigned to the Hot Palette.

Press these buttons to
hear the program with-
out the effect loaded into
Machine A, or B.

Active as soon as any
changes are made to the pro-
gram, this button can be used
with Original to perform an
easy edit/compare.



NuVerb User Guide Reference

67

67

Expanded Views
From the Program Edit view, clicking on the EFFECT EDIT box, or on the Effect A (or B) Edit
button provides a second level of detail. Only the viewing area of the Program Editor is
modified. Some effects have a third level of detail which is viewed by clicking on a non
parameter-type box in the viewing area, or on Effect Detail buttons (such as the one labeled
"Reverberator" below) in the Control Panel. Highlighted buttons on the Control Panel indicate
which view is currently selected, and what other views are available.

Fader
When the fader is visible on the screen, the slider will respond to mouse control, changing
values through the entire available range. Alternatively, you can use the keyboard up and
down arrowed keys to increment or decrement values. Click the mouse, or press enter on the
keyboard to assign a value to the parameter, and hide the fader.

Click here ...

... to display the effect parameters

Click here ... or here ...

or here ...

... to display additional effect parameters

Double click on any  parameter box
to select it and to pop up a fader.

Use the mouse, or the keyboard
↑ and ↓ keys to move the fader
and adjust the parameter value.
Some parameters provide fine
control via the commands op-
tion ↑ and option ↓.
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The Hot Palette
Parameters are assigned to the Hot Palette via the Program Editor Fader/MIDI Cntl  button.
Faders are available for Hot Palette parameter boxes, just as in the Edit window.

Parameter boxes allow
fader control of assigned
program parameters or MIDI
controllers.

Name of currently active
program is displayed here.

Opens a display showing fad-
ers assigned to multiple cards
and/or parameters.

Toggles effect bypass on the
currently selected NuVerb
card.

This area displays incoming
time code, or internal clock.

Displays the NuVerb card
which is currently selected.
Click to open a dialog box
which allows selection of an-
other NuVerb card.

Toggles NuVerb on and off
line.

This area displays the frame
rate selected under NuVerb
Preferences.

When solid, indicates MIDI
time code lock.

Fader Data
A dialog box is available from the Hot Palette Fader Data  button which displays Hot Palette
program parameter, MIDI controller, and NuVerb card data as you have currently assigned
it.
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The Fader/MIDI Control Dialog
A dialog box is available from the Program Editor  Fader/MIDI Cntl  button which allows you
to configure the Hot Faders.

In the Program Editor, click on the
Fader/MIDI Cntl button to open the
dialog Select a parameter to control...

Click on a parameter box  to
pop up a parameter menu.

Radio buttons allow you to specify
the type of parameters which will
appear in the pop-up menu.

The parameter you selected
is displayed here.

The parameter type you selected
(Program, Effect, etc.) is displayed
here. Allow selection of minimum

and maximum values for the
controller.

Displays the current
parameter  value.

Allow selection of a specific
range (minimum to maximum)
to be assigned to the control-
ler.

Once you've selected a parameter, a set of assignment options will appear.

Allows selection of Hot Palette faders 1-5,
or any MIDI controller to be selected.

Allows selection of MIDI Channel
assigned to controller.
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The  MIDI Setup Window
Once you have rebooted NuVerb with your MIDI driver selections, the MIDI menu items
under Options  —  MIDI Setup ... (Command M) and Open MIDI Input Window (Command
I)  will be enabled.

Open MIDI Input Window (Command I)  opens a status window where you can verify the
current status of your MIDI configuration.

MIDI Setup ... (Command M) opens the MIDI Setup window where you can select the MIDI
drivers/devices that will send MIDI control information to NuVerb.

Click here to open a menu which allows you to choose
which slot is being configured for MIDI. The default selection
is the first NuVerb card in your system.

Click on one of these boxes to
enable MIDI Channels. Click
again to disable recognition
of MIDI messages on that
channel.

Launch OMS

Once you have made port
assignments, clicking on any
of  these eight fields will pop
up a menu for selection among
the MIDI devices you've
defined for your system (via
Patchbay and/or Studio
Setup).

Click on a port assignment box to open a
menu which allows you to choose a data port
for the selected setup.

Click here to enable recognition
of MIDI Program Change
mesages on all MIDI channels
selected for this port.

When OMS is selected from the
Preferences menu, this button is
available to open OMS Studio
Setup and make changes to the
OMS Setup.

Click here to update the selected MIDI setup without closing the window.
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The Automation List
The Automation List is opened from the Windows menu, and can be configured under
Preferences to automatically open when the program is booted.

When active, click here to
load the selected program
making it the current program
on the selected Nuverb card.
If the Hot Palette is looking at
the same NuVerb card, the
Current Program display on
the Hot Palette will display
the program name.

Click here to enable the Automation list.
Note: you must supply MIDI Time code
to synchronize the list and provide a
timing source.

Select any event's starting
timecode display, and click
here to replace it with cur-
rent timecode as displayed
on the Hot Palette.

Click here to add a comment
line at the current timecode
entry.

Click here to open a dialog box
allowing  offset of the selected
list item(s) by adding or sub-
tracting Time Code to their
current values.Keyboard Shortcuts

Record ctrl R
Play ctrl P

Editor ctrl E
Capture ctrl C

Add Comment ctrl A
Offset ctrl O

Click here to select a smaller window for
monitoring. (The monitor view will have a
button in this location labeled Editor which
will return you to this view.

When active, click here to
open a Program Editor  for the
selected program.

Click here to enable the list
for playback.
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NuVerb Preferences
As with most Macintosh programs, Preferences (in the Edit menu) allows you to specify
certain application restrictions. In NuVerb, these options are extensive, and involve, among
other things, assignment of MIDI channels, and selection of audio formatting. Reboot NuVerb
after setting preferences.

To use MIDI with NuVerb, you must
select one or both types of MIDI drivers
here, and then restart the application.

Click here to remove OMS device IDs if they are
removed from your system. After resetting,
reconfigure your MIDI setup in the MIDI Setup
window.

Once you've made your selections,
click here and reboot NuVerb.
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NuVerb Menus
File

New Library Command N
Opens a library window titled Lib: 1. Subsequent new libraries will be
named 2, 3, etc.
Open... Command O
Opens a dialog box allowingyou to open disks, files, folders and
applications
Close Command W
Closes the active window
Save Command S
Saves any changes made to the current document since the last save
operation
Save As...
Opens a dialog box allowing a copy of the current document to be
saved with a different name, to a different location, or in a different
format
Revert
Removes all changes to the current document since the last save
operation
________________________________________________________________________________

Quit Command Q
Closes the current application. If no Save operation has been per-
formed, opens a dialog box providing for the options: Don’t Save
(Command N), Cancel, or Save.
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Edit

Cut Command X
Cuts selected text or graphics and temporarily stores it in the Clipboard
Copy Command C
Copies selected text or graphics and temporarily stores the copy in the
Clipboard
Paste Command V
In libraries, inserts contents of Clipboard above selection; if no selec-
tion, inserts at end of list. In Automation, calls a dialog box for timecode
entry
Clear Command B
Removes selected text or graphics without storing it
________________________________________________________

Select All Command A
Selects all objects in the active window or on the desktop
________________________________________________________

Preferences...
Opens a dialog box allowing selection of system configuration items
________________________________________________________

Snapshot
Available in the Fader/MIDI Cntl window. Saves changes as a new
program listing at the end of the library currently assigned to the Hot
Palette. (New listing will have same name as the current program.)
Options



NuVerb User Guide Reference

75

75

Options

Create Default Library Command L
Opens a library listing of NuVerb preset programs. Multiple Default
Libraries can be opened. They will be titled: Untitled 1, Untitled 2, etc.
_____________________________________________________________

MIDI Setup . . . Command M
Opens a status window for viewing current MIDI configuration
Open MIDI Input Window Command I
Opens a setup window for configuring MIDI devices
_____________________________________________________________

Ignore Incoming Timecode Command T
Toggles selection of NuVerb recognition of an external timecode source
Set Timecode Start ...
Opens a dialog box allowing timecode entry.
Start/Stop Internal Timer Command G
Toggles start/stop of timecode from the Macintosh internal timer.
_____________________________________________________________

Smooth While Recording
Toggles selection of smoothing.
Ask Before Smoothing
Toggles dialog box for each instance of smoothing
_____________________________________________________________
Download on Click
Toggles option of having library programs load when clicked
_____________________________________________________________
30 Frame Non-Drop
29.97 Drop-Frame
25 Frame
24 Frame

Windows

Hot Faders Command F
Toggles display of the NuVerb Hot Palette
FX Automation™ Command E
Toggles display of the NuVerb Automation window
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Effects and Parameters
Effects available in the Single Mode:
Random Hall

General Description
NuVerb incorporates the results of a great deal of research into acoustics and reverberation.
Reverberation, or reflected sound energy, gives recorded music a sense of being performed in
a real acoustic location.

In NuVerb, the SIZE, SPREAD and SHAPE controls allow  adjustment of the buildup and decay
of the initial part of the reverberation envelope. SHAPE controls the shape of the envelope,
while SPREAD and SIZE set the time over which this shape is active.

In the Random Hall effect, SIZE acts as a master control for the apparent size of the space being
created by NuVerb. Both SPREAD and  RTIM vary linearly  with the setting of SIZE. Thus
maximum reverb time and spread require high settings of SIZE. To find an appropriate reverb
sound, start with a preset with a similar sound to what you want to end up with. Simply
varying SIZE is often sufficient to arrive at the exact sound you are seeking.

Once a size has been selected, SPREAD and SHAPE are used to adjust the shape and duration
of the initial reverb envelope, which together provide the major sonic impression of room size.

When SHAPE is at minimum, the reverberation envelope builds up very quickly to a
maximum amplitude, and then dies away quickly at a smooth rate. This envelope is character-
istic of small reverberation chambers and reverberation plates. There are few (if any) size cues
in this envelope, so it is ineffective in creating ambience. With this SHAPE setting, SPREAD has
no effect. The density is set by the size control, and the rate of decay is set by RTIM. This
reverberation envelope is typical of many of the popular digital reverberators of the last few
years.
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As SHAPE is raised to about 1/8 of its range, the initial sharp attack of the reverberation is
reduced, and reverberation builds more slowly. The envelope then sustains briefly before it
begins to die away at the rate set by RTIM. SPREAD has little or no effect on this shape.

When SHAPE is at 1/4 of its range, buildup is even slower and the sustain is longer. Now
SPREAD affects the length of both the buildup and the sustain. As a rough estimate, the sustain
will be approximately the time value indicated by the SPREAD display (in milliseconds).

As SHAPE is raised further, the buildup and sustain remain similar, but now a secondary
sustain appears in the envelope, at a lower level than the first. This secondary plateau simulates
a very diffused reflection off the back wall of a hall, and is effective in creating a sense of size
and space. This reflection becomes stronger and stronger, reaching an optimal loudness when
SHAPE is at about 1/2 of its range.

The highest SHAPE settings are typically used for effects. Near the top of the scale the back wall
reflection becomes stronger than the earlier part of the envelope, resulting in an  inverse sound.

NOTE None of these shape effects are audible unless RTIM is set short enough. Generally, RTIM
should be set to a value of about 1.2 seconds for small rooms, and up to 2.4 seconds or so for
halls. SIZE should also be set to a value appropriate to the desired hall size (note, however,
that small sizes color the reverberation).15 meters makes a very small room, and 38 meters is
useful for a large hall.

Used with care SHAPE and SPREAD allow NuVerb to produce superior ambience—a sound
which is spacious and has great depth—without the long reverberation of a church.

Random Delays
The Random Hall effect in NuVerb incorporates  random delay elements. These elements have
several effects. First, there is a reduction of long-lived modes in the reverberant decay, which
makes the decay less metallic and reduces the apparent reverb time. The random elements also
improve the steady-state timbre of the effect.
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The speed at which the delay elements move is controlled by SPIN. Values of SPIN which are
higher than about 38 can cause audible pitch wobble in very critical material (such as classical
guitar or piano and  can also cause noise on pure tones. This noise is not audible in speech,
however, and, for mixed music or speech, values up to 48 will give an improved sound.
WANDER is typically set to about 10ms at larger settings of SIZE. The effect of WANDER is
reduced for small SIZEs.

Creating a Realistic Sound
When you set out to create a sound, the first and most important decision is how big a space
you want. The best way to start is to listen to several presets and choose the one which sounds
closest to what you have in mind. If necessary, use SIZE to make a slightly larger or smaller
sound, as needed.

Next use RTIM to fine-tune the amount of time the reverberation takes to die away at the end
of musical phrases. Actual halls vary a great deal in their actual  RTIM values. The setting of
the BASS is also critical in matching the sound of an existing hall. An ideal concert hall would
have a BASS setting of 1.2. It is rare when actual physical spaces exceed 1.5. Many (if not most)
good recording environments have values of BASS of 1.0 or less, so a value of 0.8 could be tried
when attempting to match an existing hall.

There are two additional controls to deal with. SHAPE and SPREAD adjust the effective reverb
time when the music is running. Higher values of SHAPE and SPREAD produce a longer
effective reverb time. Longer effective reverb times give greater spaciousness to the sound.

The NuVerb reverberation effect offers the option of adding early reflections (pre-echoes)
which have been made into diffused clusters of pre-echoes. The density of the cluster is set by
the DIFFUSION control. We recommend that these pre-echoes be used with caution, unless
you are trying to match the sound of the reverberation to a particular location where such
reflections are strong.
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Random Hall Parameters
The Reverberator
RTIM (Reverb Time) .02 - 60.49s
RTIM sets the reverb time for mid-frequency signals. Because low-frequency reverb time
(BASS) is a multiplier of RTIM, RTIM acts as a master control for the reverb time.

SIZE 4.0 - 39.4M
SIZE sets the rate of buildup of diffusion after the initial period (which is controlled by DIFF).
It also acts as a master control for RTIM and SPREAD. The SIZE control changes a reverb sound
from very large to very small. Generally, you should set the SIZE control to approximate the
size of the acoustic space you are trying to create, before adjusting anything else. The size in
meters is roughly equal to the longest dimension of the space. Moving SIZE while a signal is
present may cause audible transients on critical material.

The apparent size of the space created is actually a combination of the settings of the SIZE,
SHAPE, and SPREAD controls. Small acoustic spaces are characterized by  a rapid buildup of
diffusion. However, both small and large spaces frequently have an uneven buildup of initial
reverberation. This uneven buildup is controlled by the SPREAD and SHAPE controls.

SHAPE 0 - 255
SPREAD 0 - 250
SHAPE and SPREAD work together to control the overall ambience of the reverberation
created by NuVerb. SHAPE determines the contour of the reverberation envelope. With
SHAPE all the way down, reverberation builds explosively, and decays quickly.

As SHAPE is advanced, reverberation builds up more slowly and sustains for the time set by
SPREAD. With SHAPE in the middle, the buildup and sustain of the reverberation envelope
emulates a large concert hall (assuming that SPREAD is at least halfway up, and that SIZE is
suitably large—30 meters or larger.)

SPREAD works together with SHAPE to control the duration of the initial ambience created
by NuVerb. Low SPREAD settings result in a rapid onset of reverberation at the beginning of
the envelope, with little or no sustain. Higher settings spread out both the buildup and sustain.
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XOVR (Bass Crossover) 0.1 - 26.5kHz
XOVR sets the frequency at which the transition from RTIM to BASS takes place. XOVR should
be set at least two octaves higher than the low frequency you want to boost. For example, to
boost a signal at 100 Hz, set XOVR to 400 Hz (This setting works well for classical music). XOVR
works best around 400 for boosting low frequencies, and around 1.5 kHz for cutting low
frequencies.

BASS (Bass Multiply) 0.2x - 4.0x
BASS sets the reverb time for low-frequency signals, as a multiplier of the RTIM parameter. For
example, if BASS is set to 2X, and RTIM is set to two seconds, the low frequency reverb time
will be four seconds. For a natural-sounding hall ambience, we recommend values of 1.5X or
less.

TDCY (Treble Decay) 0.5 - 21.2kHz
TDCY sets the frequency above which sounds decay at a progressively faster rate. It filters all
the sound except the pre-echoes. When set relatively low, it gives a darker tone to the
reverberation, simulating the effect of air absorption in a real hall. TDCY also helps keep the
ambience generated by the effect from muddying the direct sound.

LINK Link/Unlink
When LINK is set, the reverb time and spread values scale linearly as the SIZE control is varied.
For some special effects, RTIM and SPRD can be unlinked.

SPIN (Randomization) 0 - 48
SPIN affects the rate of change of the timbre. The object  of SPIN  (and WAND) is to
continuously alter the timbre of the reverberant sound. This makes the result more natural,
without making the position of instruments unstable. SPIN should typically be 20 or higher.
High values may make the pitch of piano or guitar unstable.

WAND (Wander)0µs - 37.1ms
WAND sets the distance in time that the reverb tail  will move relative to the rate of SPIN. For
best results WAND should be about 10ms at larger sizes.
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Diffusion, Predelay, Reverb Level, and Rolloff
DIFF (Diffusion) 0 - 99
DIFF controls the degree to which initial echo density increases over time. High settings of
DIFF result in high initial buildup of echo density, and low settings cause low initial buildup.
Echo density is also affected by SIZE; smaller spaces will sound denser. To enhance percussion,
use high settings of diffusion. For clearer and more natural vocals, mixes, and piano music, use
low or moderate settings of diffusion.

PDLY (Predelay) 0 - 1000ms
PDLY adjusts an additional time delay between the input of signal and the onset of reverbera-
tion. The control is not intended to mimic the time delays in natural spaces. In real rooms  the
build-up of reverberation is gradual, and the initial time gap is usually relatively short. Natural
spaces are best emulated by setting SHAP at a middle value and adjusting SPRD for the desired
effective pre-delay.

Additional delay added with the PDLY control can increase the initial time gap slightly,
emulating a situation where reverberant pick-up microphones are located much further from
the source than the main microphones. If less than about 30ms of pre-delay is added, this
additional delay can add clarity with some music, but it can also sound unnatural. Large pre-
delays can be useful for slap-echo effects.

RLVL (Reverb Level) Off - 48dB - Up Full
RLVL sets  the amount of reverberation in the processed signal. It is normally FULL, but may
be reduced for effects where the pre-echoes should dominate.

ROLL (High Frequency Rolloff) 0.1 - 26.5kHz, Flat
ROLL sets the frequency above which a 6 dB/octave low-pass filter attenuates the processed
signal. It attenuates both pre-echoes and reverberant sound. High frequencies are often rolled
off with this parameter, resulting in more natural sounding reverberation.

Pre-Echoes and Feedback Pre-Echoes
The Random Hall effect contains four pre-echo taps with delay and level controls. The taps are
fed directly to the output wet signal rather than into the reverberator.
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Pre-echoes can best be understood by visualizing a stage where the early reflections are the
sounds emanating from the rear and side stage walls directly after the sound from the stage.
Usually the rear stage wall reflection is earlier and louder than those from the two side walls.
The pre-echoes are actually clusters of echoes, with the density of the cluster set by DIFF.

The pre-echo delay parameters change the perceived locations of reflecting surfaces surround-
ing the source. Level adjusts the loudness of the reflection. For each of the Lvl (Pre-echo level)
parameters, there is a corresponding Dly parameter. Each of these sets the delay time in ms for
one of the pre-echoes. These are not affected by PDLY, so pre-echoes can be placed to occur
before the reverberation starts.

The Dly pre-echo delay parameters have a resolution of 2 milliseconds. (0 - 1000ms)

The Lvl pre-echo level parameters have sixteen steps, calibrated in decibels. (Off - 24dB - Up
Full)

The Fbk feedback parameters (for Delays 3 and 4 only) are adjustable in 6% increments from
-93% to +93%.

DLY1, LVL1 Pre-Echo 1, one second maximum to left channel.

DLY2,LVL2 Pre-Echo 2, one second maximum to right channel.

DLY3, LVL3, FBK3 Pre-Echo 3, 2.8 seconds maximum to left channel, with feedback.

DLY4, LVL4, FBK4 Pre-Echo 4, 2.8 seconds maximum to right channel, with feedback.
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Random Ambience

General Description
The NuVerb Random Hall effects are designed to add a cushion of reverberance to recorded
music, while leaving the clarity of the direct sound unaffected. Random Ambience is different.
It is intended to become a part of the direct sound — to give it both better blend and a definite
position in space. Random Ambience gives warmth, spaciousness and depth to a performance
without coloring the direct sound at all.

Random Ambience generates primarily the strong reflections which appear in the first few
hundred milliseconds of the reverberation process. These early reflections constitute the
primary audible effect, giving you the impression of a hall surrounding you while the music
is playing. To avoid any coloration from these strong reflections, the time delays and
amplitudes are random functions.

Random Ambience is very useful for adding a room sound to recorded music or speech. It is
particularly easy to match a studio recording of dialog to a typical room environment. In music
recording, using Random Ambience is an effective way of realistically adding distance to a
close-miked signal. If an ensemble has been recorded with close-mikes and pan pots, Ambi-
ence can provide the missing blend and depth. The apparent position of the instruments is
preserved in the reverb while the apparent distance is increased. Random Ambience is also
useful in matching a closely miked accent microphone to the overall ambience of a recording.
This allows a soloist to be increased in level without changing the apparent distance. Random
Ambience can be used in a recording situation any time a close-miked sound is undesireable.

Set the SIZE to the desired room size. RLVL adjusts the amplitude of reverberation defined by
RTIM, and can be trimmed to get exactly the effect you need.

To use the effect with a console, it is best to use a stereo send to NuVerb, carefully matching
the panning of the various close-miked sources to their positions in the mix. Leave the MIX
control at 100%. The apparent distance of each source can be controlled by the level of its feed.
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Random Ambience Parameters
The Ambience Generator
SIZE 4.0 - 39.4M
SIZE allows you to vary the apparent size of the space over a wide range. SIZE is the most
dramatic control, and must be selected to match the music or effect material. It should be the
first control that you adjust to tailor the desired space. SIZE also affects the reverb time, in a
similar way to the standard reverb effects.

RTIM (Reverb Time) 0.18 - 47.82s
RTIM adjusts the reverberation time of the independent reverberator. The range of action is
limited. Be careful — both long and short reverb times may sound unnatural. If a much longer
or shorter reverb time than the preset provides is desired, SIZE should be changed first.

RLVL (Reverb Level) Off, -48 - 1dB, Up Full
RLVL sets  the amount of reverberation in the processed signal. It is normally FULL, but may
be reduced for effects where the pre-echoes should dominate.

SPIN (Randomization) 0 - 48
SPIN affects the rate of the movement of many of the early reflections. The object of SPIN  (and
WAND) is to continuously alter the timbre of the reverberant sound. This makes the result
more natural, without making the position of instruments unstable. SPIN should typically be
20 or higher. High values may make the pitch of piano or guitar unstable.

WAND (Wander)0 - 37.1ms
WAND sets the distance in time that the early reflections will move. For best results WAND
should be about 10ms at larger sizes.
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Diffusion, Predelay, Rolloff and Dry Delay
DIFF (Diffusion) 0 - 99
DIFF controls the degree to which initial echo density increases over time. High settings of
DIFF result in high initial buildup of echo density; low settings cause low initial buildup. Echo
density is also affected by SIZE; smaller spaces will sound denser. To enhance percussion, use
high settings of DIFF. For clearer, more natural vocals, mixes, and music, use low or moderate
settings.

PDLY (Predelay) 0 - 99.9ms
PDLY adds an additional delay to the reflections and to the reverberation. This control may be
useful in a sound reinforcement situation, or for ambience effects. Both DDLY and PDLY have
4-sample (approximately 0.1msec)  resolution.

ROLL (High Frequency Rolloff) 0.5- 21.2kHz
ROLL sets the frequency above which a 6 dB/octave low-pass filter attenuates the processed
signal. It attenuates both pre-echoes and reverberant sound. High frequencies are often rolled
off with this parameter, resulting in more natural sounding reverberation.

DDLY (Dry Delay) 0 - 99.9ms
DDLY provides a delay for the “dry” audio path.
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Rich Plate

General Description
The Rich Plate effect is denser, smoother, and more colored than other reverb effects. When
used with the SIZE control at around 16 meters, the sound is dense and tight — ideal for
percussion. Larger sizes and longer reverb times are suitable for vocals and brass.

Rich Plate Parameters
The Reverberator
RTIM (Reverb Time) 0.15 - 40.46s
RTIM adjusts the reverberation time of the independent reverberator. The range of action is
limited. Be careful — both long and short reverb times may sound unnatural. If a much longer
or shorter reverb time than the preset provides is desired, SIZE should be changed first.

SIZE 4.0 - 39.4M
SIZE allows you to vary the apparent size of the space over a wide range. SIZE is the most
dramatic control, and must be selected to match the music or effect material. It should be the
first control that you adjust to tailor the desired space. SIZE also affects the reverb time, in a
similar way to the standard reverb effects.

SHAPE 0 -255
SPREAD 0 -250
SHAPE and SPREAD work together to control the overall ambience of the reverberation
created by NuVerb. SHAPE determines the contour of the reverberation envelope. With
SHAPE all the way down, reverberation builds explosively, and decays quickly.

As SHAPE is advanced, reverberation builds up more slowly and sustains for the time set by
SPREAD. With SHAPE in the middle, the buildup and sustain of the reverberation envelope
emulates a large concert hall (assuming that SPREAD is at least halfway up, and that SIZE is
suitably large—30 meters or larger.)
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SPREAD works together with SHAPE to control the duration of the initial ambience created
by NuVerb. Low SPREAD settings result in a rapid onset of reverberation at the beginning of
the envelope, with little or no sustain. Higher settings spread out both the buildup and sustain.

XOVR (Bass Crossover) 0.1 - 26.5kHz
XOVR sets the frequency at which the transition from RTIM to BASS takes place. XOVR should
be set at least two octaves higher than the low frequency you want to boost. For example, to
boost a signal at 100 Hz, set XOVR to 400 Hz. (This setting works well for classical music.)
XOVR works best around 400 for boosting low frequencies, and around 1.5 kHz for cutting low
frequencies.

BASS (Bass Multiply) 0.2x - 4.0x
BASS sets the reverb time for low-frequency signals, as a multiplier of the RTIM parameter. For
example, if BASS is set to 2X, and RTIM is set to two seconds, the low frequency reverb time
will be four seconds. For a natural-sounding hall ambience, we recommend values of 1.5X or
less.

TDCY (Treble Decay) 0.5 - 21.2kHz
TDCY sets the frequency above which sounds decay at a progressively faster rate. It filters all
the sound except the pre-echoes. When set relatively low, it gives a darker tone to the
reverberation, simulating the effect of air absorption in a real hall. TDCY also helps keep the
ambience generated by the effect from muddying the direct sound.

LINK Link/Unlink
When LINK is set, the reverb time and spread values scale linearly as the SIZE control is varied.
For some special effects, RTIM and SPRD can be unlinked.

RAND (Randomization) Off, -48dB - Up Full
RAND sets the rate of randomization of the reverb tail.
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Diffusion, Predelay, Reverb Level, and Rolloff
DIFF (Diffusion) 0 - 99
DIFF controls the degree to which initial echo density increases over time. High settings of
DIFF result in high initial buildup of echo density; low settings cause low initial buildup. Echo
density is also affected by SIZE; smaller spaces will sound denser. To enhance percussion, use
high settings of DIFF. For clearer, more natural vocals, mixes, and music, use low or moderate
settings.

PDLY (Predelay) 0 - 1000ms
PDLY adds an additional delay between the input signal and the onset of reverberation. This
control may be useful in a sound reinforcement situation, or for ambience effects. Both DDLY
and PDLY have 4-sample (approximately 0.1msec)  resolution.

RLVL (Reverb Level) Off, -48dB - Up Full
RLVL sets  the amount of reverberation in the processed signal. It is normally FULL, but may
be reduced for effects where the pre-echoes should dominate.

ROLL (High Frequency Rolloff) 0.1 - 26.5kHz, Flat
ROLL sets the frequency above which a 6 dB/octave low-pass filter attenuates the processed
signal. It attenuates both pre-echoes and reverberant sound. High frequencies are often rolled
off with this parameter, resulting in more natural sounding reverberation.

Rich Plate Delays and Feedback Pre-Echoes
Rich Plate provides control over three stereo delay pairs. All three are summed with the output
of the reverberator. Many, many different echo combinations are possible.

DLY1 (Delay 1), DLY2 (Delay 2) 0 - 2000ms
DLY1 and DLY2 are recirculating delay lines to the left and right channel inputs. The path of
either is picked off after the diffusor with the amount of recirculation defined by the adjustment
of FBK1 (for DLY1) and FBK2 (for DLY2). DLY1 and DLY2 are the only delays which effectively
feed back (recirculate) into the reverberator.
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FBK1 (Feedback 1), FBK2 (Feedback 2) 0 - 93%
FBK1 and FBK2 determine the amount of recirculation passed back through to the left and right
inputs.

DLY3 (Delay 3), DLY4 (Delay 4) 0 - 1000ms
DLY3 (and DLY4 are also picked off after the diffusor. The level of each is controlled by LVL3
and LVL4, respectively.

LVL3 (Level 3), LVL4 (Level 4) Off - 24dB, Up Full
LVL3 and LVL4 determine the loudness of DLY3 and DLY4.

DLY5 (Delay 5), DLY6 (Delay 6) 0 - 2800ms
DLY5 and DLY6 allow you to build non-diffused recirculating echoes independant of the
reverberator. Each has a feedback control (FBK5 and FBK6).

FBK5 (Feedback 5), FBK6 (Feedback 6) 0 - 93%
FBK5 and FBK6 provide feedback control for DLY5 and DLY6.

LVL5 (Level 5), LVL6 (Level 6) Off, -48dB - Up Full
LVL5 and LVL6 determine the loudness of DLY5 and DLY6. Remember, these are undiffused
pre-echoes.
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Stereo Adjust

General Description
The Stereo Adjust effect offers fine adjustments of level and equalization during digital
mastering. Its stereo digital fader permits 0.25dB trimming and provides full fades to digital
zero at the end of a track. Its two sets of shelving treble EQ can be set for different 3dB points
and gains. BASS and SPEQ permit adjustment of stereo width, enhancing the spaciousness and
depth of the recording.

Stereo Adjust Parameters
The Equalizer
BXVR (Bass Crossover) 0.1 - 26.5kHz
BXVR sets the crossover point for BASS and SPEQ. When BASS  is set to full cut, the level is -
3 dB at the frequency set with BXOV.

BASS+ (Bass EQ)Cut, -18dB - +12dB
BASS is a  6dB/octave shelving EQ control with a range of +6 dB boost and -18dB cut. It moves
in .50 dB steps from +6 to -6 dB. The crossover point is adjusted with BXVR. BASS acts on both
stereo channels equally.

SPEQ (Spatial EQ) Cut, -6 - +6dB
SPEQ sets the amount of a crossfeed between channels. The signal first goes through a 6 dB/
octave low-pass filter whose frequency is set with BXVR.

When SPEQ is set positive (above 0) the crossfeed has a negative sign. When SPEQ is set
negative (below 0), the crossfeed has a positive sign. When the control is set to either maximum
or minimum, the gain in the crossfeed circuit is unity.

The result of this control is to change the separation of low frequency stereo signals. When the
control is raised, low frequencies in the sum (mono) channel are reduced, and low frequencies
in the difference (stereo) channel are raised. With the control at maximum, low frequency
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mono signals are completely removed. This represents an extreme setting which should
seldom be needed in practice.

With material which has stereo bass information, or which contains some reverberation, the
effect of raising SPEQ is to increase the sense of spaciousness and depth of the sound. It is
particularly useful on material recorded with panpots, or coincident and semi-coincident
microphone technique.

When most of the bass in a recording is in the sum (mono) channel,  raising SPEQ may reduce
the bass level. This effect can be compensated for by raising the overall bass level with BASS.
Since both controls use the same BXVR setting, this compensation will be quite accurate as long
as SPEQ is set to less than 3 dB boost.

TRXVR (Stereo Treble Crossover) 0.1 - 26.5kHz
TRXVR sets the crossover point for TREB. When TREB is set to full cut, the level is -3 dB at the
frequency set with TXOV.

TREB+ (Treble EQ) Cut, -18 - +6dB
TREB+ is a  6 dB/octave shelving EQ controls with a range of +6 dB boost and -18dB cut. It
moves in .50 dB steps from +6 to -6 dB. The crossover point is adjusted with TXRXVR. TREB+
acts on both stereo channels equally.

D-EM (De-emphasis) On/Off
When D-Em is On, the incoming signal is digitally de-emphasized. This should not be used
unless the material has been emphasized in the record process— such as a PCM-F1 tape.

When digital de-emphasis is applied, the CD mastering lab must be informed that the tape is
not emphasized, and the CD emphasis bit should be manually set to Off. Mastering labs are
happy to do this, but they must be informed!

L/RXVR (Independent Treble Crossover) 0.1 - 26.5kHz
L/RXVR sets the crossover point for LTRB and RTRB.  When either  is set to full cut, the level
is -3 dB at the frequency set with TRXVR.
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L TRB+ (Left Treble Adjust), RTRB+ (Right TrebleAdjust) Cut, -18 - +6dB
These controls allow independent adjustment of left and right treble. They may be used
together with the stereo adjustments to create a 12 dB/octave cut or boost. Note that  the 3 dB
frequencies can be different from the stereo set.

Stereo Adjustments
MSTR (Master Level) Off, -72 - +12dB
MSTR is a stereo level control, with both channels equally attenuated or boosted. From -12 to
+12 the fader moves in .25 dB increments. Below -12 it moves in .50 dB increments. Below -60
dB the calibration comes in larger steps, finally dropping to zero output at -72 dB.

11µs (1/2 Sample)On/Off
When this control is on, the left channel is delayed relative to the right by 11µsec (1/2 sample).
This control specifically corrects for the timing error between channels caused by consumer
digital systems (e.g. the Sony PCM-F1 and its progeny) that time-share single analog convert-
ers. Turning on this delay time aligns the left channel audio data for compatibility with
professional systems.

R F’n’S (Right Channel Flip ‘n’ Swap) +L-R, +L-R+R+L, -R+L
RFnS is used for digitally correcting problems you used to be able to fix (or create) by switching
analog cables around. The normal setting is +L to the left output and +R to the right output.
Other settings should only be used when correcting some problem created previously in the
recording process.

+L+R = Normal Routing
+L-R = Right Channel polarity inverted (flipped)
+R+L = Left and Right Channels swapped
-R+L = Right flipped and swapped with Left

BAL (Balance) L+2.9dB- R+2.9dB
BAL implements a sine/cosine balance adjustment. Balance is smoothly adjusted over a wide
range, with excellent resolution in the critical area around zero. The display indicates the actual
channel gains as the control is varied.
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ROT (Rotate) L+2.9dB- R+2.9dB
ROT is similar to BAL, but it treats stereo information somewhat differently. Any signal
panned to the center (mono) will be treated by ROT exactly as it would be treated by BAL.
However, if a signal is panned full right and the control is moved toward the left, instead of
simply being attenuated (as BAL would do) the right channel is inverted in phase and added
to the left channel. A stereo image appears to rotate when this control is used. Ambient
information is preserved, and both channels appear to retain equal loudness.

If stereo material is recorded with a coincident pair of figure-of-eight microphones, moving the
ROT slider is exactly equivalent to rotating the microphone pair. Other microphone arrays and
multimicrophone setups do not rotate perfectly, but using this control is frequently preferable
to simply adjusting balance. The display shows the actual channel gains for a continually
panned source.

L/R DLY (Stereo Delay) 0 - 5000ms
L/R DLY controls a 5-second stereo delay line, with a resolution of 10 milliseconds. Separate
mono and fine controls are provided. This is a post-processing full-level delay, and is always
in the circuit.

Delays and Feedback Controls
These controls give individual channel control over the 5-second post-equalization delay line.

LDLY (L Delay) 0 - 5000ms
L/R DLY and LDLY provide 5-second, 10 milliseconds per step, mono control for the left
channel. Together, these two controls must not total more than 5,000 milliseconds.

RDLY (R Delay) 0 - 5000ms
L/R DLY and RDLY provide 5-second, 10 milliseconds per step, mono control for the right
channel. Together, these two controls must not total more than 5,000 milliseconds.
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Fine Sample Accurate Delays can be used for subtle time alignment adjustments. NuVerb will
correctly display the resulting time shift as a function of the sampling rate. As many as 500
samples can be added to any stereo/coarse delay setting for a maximum possible delay per
channel of 5 seconds + 500 samples.

48 kHz = 20.833 microseconds per sample
44.1 kHz = 22.676 microseconds per sample
32 kHz = 31.25 microseconds per sample

LFIN (Left Channel Fine)0 - 500 Samples
LFIN provides 500-sample, 1 sample per step, mono fine adjust for the left channel.

RFIN (Right Channel Fine) 0 - 500 Samples
RFIN provides 500-sample, 1 sample per step, mono fine adjust for the right channel.

Two feedback paths are available per channel: overall and fine. Overall feedback is the total
delay of DLAY + L(R)DLY + L(R)FIN, and is useful for long echo effects.

Fine Feedback is only around the Fine Delay and can be used for very short delay effects and
coloration.

All feedback gains are adjustable in 1% increments from -99% to +99%. If the magnitudes of
both feedback gains for a channel sum to more than 100%, that channel will take off and
overload.

Overall and fine are distinguished by upper and lower case lettering:
LFBK = Overall Left Channel Feedback
Lfbk = Fine Delay Adjustment of Left Channel Feedback
RFBK = Overall Right Channel Feedback
Rfbk = Fine Delay Adjustment of Right Channel Feedback
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DC Offsets
DCSW (DC Offset Nulling) Reset, Manual, Auto
DCSW provides three choices: RESET, MANUAL ADJUST, and AUTO ADJUST. RESET
disables all DC adjustment. AUTO ADJUST enables routines for correcting DC offset from
material recorded through analog-to-digital converters that are not properly trimmed for DC.
MANUAL ADJUST allows selection of specific offset values.

L-DC , R-DC (Left and Right Channel Offset)
These controls allow replacement of any previously obtained value with the value selected
here. The percent of the correction will be displayed.

SHUF (Shuffler — Binaural)
SHUF controls a spatial equalizer designed for recording made with a dummy head or closely
spaced omni microphones.
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Programs Available in the Dual Mono and Cascade Modes:
Dual Delay

General Description
The Dual Delay effect consists of 2 types of delay lines: Gliding Flange delays and Fixed delays.
This is a true stereo effect. (If run in Dual Mono mode, however, it will be mono.)

Two independent gliding flange predelays are available, each with a 10ms range in single
sample steps. There is also a ganged stereo gliding flange delay. There are two flange gain
controls which vary the overall amount of flange effect.

Setting the flange gains very high will cause an “over the top” type of flange to occur as the
flange glide delays cross over the predelay pointers. The outputs of the flange delays are fed
to the delay left and delay right lines which are 2.5 seconds long. Once into these delay lines,
you can create many different delay effects. There are two programmable taps on each delay
line. Delays 1 (left) and 2 (right) can be programmed anywhere along this 2.5 second path.
There will, however, be no apparant delay unless a feedback value is assigned to the delay
values via feedback parameters 1 and 2. All Pass filters, or diffusors, in line with the feedback
paths are labeled APD (All Pass Delay) and APG (All Pass Gain). The actual “tuning” of the All
Pass Delay is accomplished with the APD control. The amount of diffusion is set by APG.
When APG is turned high and FBK 1 is adjusted away from the 0% value, each feedback loop
will be rediffused.

Delays 3 and 4 are cross feedback delay lines. They are also adjustable anywhere along the 2.5
second delay line. Delay 3 feeds from the left delay position to the input of the right delay line.
The same is true with Delay 4 feeding into the left delay line. The feedback parameters adjust
the amount (level) passed into the destination delay lines.

The last pair of delay pointers (LDLY and RDLY) can be thought of as independently adjustable
post delays. These can be adjusted anywhere along the 2.5 second delay line.

The output of each delay line can be positioned anywhere in the stereo pan field. LPAN adjusts
the position of the left delay loop; RPAN positions the output of the right delay loop.
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Dual Delay Parameters
The Flanger
FLNGDLY (Flange Delay) 0-479 samples = 0- 20ms
FLNGDLY is a separate 20 ms ganged stereo delay line which is controllable in single sample
steps.

LPDLY, RPDLY (Left , Right Flange Base Delays 0-479 samples = 0-20ms
LPDLY and RPDLY are base delays which get summed with the stereo ganged flange
delay.These base delays are adjustable in single sample steps throughout a 20 millisecond
range.

LFLG, RFLG (Left, Right Flange Gain) -99% to +99%
LFLG and RFLG are flange gains which are adjustabe as a feed forward amplifier loop (+99%
positive value) or feedback amplifier loop (-99% negative value).

Delay and Feedback Controls
DLY1, DLY2 (Delay 1, Delay 2) 0-19996 samples = 0-2498.9ms
DLY1 and DLY2 set the delay values for the respective left to left and right to right feedback
loops

FBK1, FBK2 (Feedback 1, Feedback 2) -99% to +99%
FBK1 and FBK2 set the gain of feedback for each of the delay lines. Available values range from
-99% to +99% gain.

APD1, APD2 (All-pass L and R Delays) 0-19996 samples = 0-2498.9ms
APD1 and APD2 are diffusors in series with the feedback loops associated with DLY1 and
DLY2. Their controls range from 0 to 10 ms. These controls essentially “tune” the diffusor delay
line.

APG1, APG2 (All-pass L and R Gain) 0 - 191
APG1 and APG2 are gains associated with the diffusors. You can think of them as controlling
the amount of diffusion for delay lines 1 and 2.
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DLY3, DLY4 (Delay 3, Delay 4) 0-19996 samples = 0-2498.9ms
DLY3 controls the delay time which cross-feedbacks to the input of DLY2. DLY4 controls the
delay time which cross-feedbacks to the input of DLY1.

FBK3, FBK4 (Feedback 3, Feedback 4) 0 - 99%
FBK3 and FBK4 control the gain of the cross feedbacks going with each of their respective delay
lines.

LDLY, RDLY (L and R Delays) 0-19996 samples = 0-2498.9ms
LDLY sets the left channel delay line’s time. RDLY sets the right channel delay line’s time.

LPAN, RPAN (Left and Right Pan Placement) L, 0-98%R/L, R
LPAN adjusts the left delay channel pan placement. RPAN adjusts the right delay channel pan
placement
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Split Chamber

General Description
The Split Chamber effect can simulate many different types of acoustic spaces or mechanical
devices. This effect is great on anything. Sizes of 25 and larger set a lower acoustic density.
Shape and Spread help create the illusion of larger spaces while using short reverb times. As
in the Random Hall effect, the Link parameter couples the Size parameter to the reverb time
and Spread. Unlink provides a method of setting stable reverb time and Spread values, then
adjusting size to set the right density and “tuning”. Split Chamber is bright by design, so you
may want to use lower values of treble decay — maybe even as low as 1.0kHz or 500Hz.

The randomization circuit in Split Chamber is designed to reduce coloration and/or frequency
nodes caused by low frequency input. If you want to create your own special Chambers or
Halls, you should keep RAND set to 90 or 95.

Typically, sizes of 14-24 meters with treble decays higher than3.4kHz will emulate bright
sounding metal plates. Remember to set the shape and spread parameters to extremely low
values to maintain the explosivness of the reverb decay. Because plates are very diffuse, any
preset mimicking a plate should have diffusion set relatively high (70-80), while the bass
multiplier is kept to some value less than 1.2kHz.

The diffusion and predelay parameters precede the reverberator. When Chamber effects are
loaded into Dual Mono mode, the audio will be Mono In-Mono Out.  When loaded into
Cascade mode, audio is routed summed Mono In-Stereo Out.

Split Chamber Parameters
Split Chamber (the reverberator)
RTIM (Mid-Frequency Reverb Time) .09 - 24.11s
RTIM sets the reverb time for mid-frequency signals. Because low-frequency reverb time
(BASS) is a multiplier of RTIM, RTIM acts as a master control for the reverb time.
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SIZE 4.0 - 66.4M
SIZE sets the rate of buildup of diffusion after the initial period (which is controlled by DIFF).
It also acts as a master control for RTIM and SPRD. The SIZE control changes a reverb sound
from very large to very small. Generally, you should set the SIZE control to approximate the
size of the acoustic space you are trying to create, before adjusting anything else. The size in
meters is roughly equal to the longest dimension of the space. Moving SIZE while a signal is
present may cause audible transients on critical material.

The apparent size of the space created is actually a combination of the settings of the SIZE,
SHAP, and SPRD controls. Small acoustic spaces are characterized by  a rapid buildup of
diffusion. However, both small and large spaces frequently have an uneven buildup of initial
reverberation. This uneven buildup is controlled by the SPRD and SHAP controls.

SHAPE 0 - 255
SPREAD 0 - 202
SHAP and SPRD work together to control the overall ambience of the reverberation created by
NuVerb. SHAP determines the contour of the reverberation envelope. With SHAP all the way
down, reverberation builds explosively, and decays quickly.

As SHAP is advanced, reverberation builds up more slowly and sustains for the time set by
SPRD. With SHAP in the middle, the buildup and sustain of the reverberation envelope
emulates a large concert hall (assuming that SPRD is at least halfway up, and that SIZE is
suitably large—30 meters or larger.)

SPRD works together with SHAP to control the duration of the initial ambience created by
NuVerb. Low SPRD settings result in a rapid onset of reverberation at the beginning of the
envelope, with little or no sustain. Higher settings spread out both the buildup and sustain.

XOVR (Bass Crossover) 0.1 - 26.5kHz
XOVR sets the frequency at which the transition from RTIM to BASS takes place. XOVR should
be set at least two octaves higher than the low frequency you want to boost. For example, to
boost a signal at 100 Hz, set XOVR to 400 Hz (This setting works well for classical music). XOVR
works best around 400 for boosting low frequencies, and around 1.5 kHz for cutting low
frequencies.
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BASS (Bass Multiply) 0.2x - 4.0x
BASS sets the reverb time for low-frequency signals, as a multiplier of the RTIM parameter. For
example, if BASS is set to 2X, and RTIM is set to two seconds, the low frequency reverb time
will be four seconds. For a natural-sounding hall ambience, we recommend values of 1.5X or
less.

TDCY (Treble Decay) 0.5 - 21.2kHz
TDCY sets the frequency above which sounds decay at a progressively faster rate. It filters all
the sound except the pre-echoes. When set relatively low, it gives a darker tone to the
reverberation, simulating the effect of air absorption in a real hall. TDCY also helps keep the
ambience generated by the effect from muddying the direct sound.

LINK Link/Unlink
When LINK is set, the reverb time and spread values scale linearly as the SIZE control is varied.
For some special effects, RTIM and SPRD can be unlinked.

RAND (Randomization) Off, 0 - 98%, Up Full
RAND sets the rate of randomization of the reverb tail.

Diffusion and Predelay
DIFF (Diffusion) 0 - 99
DIFF controls the degree to which initial echo density increases over time. High settings of
DIFF result in high initial buildup of echo density; low settings cause low initial buildup. Echo
density is also affected by SIZE; smaller spaces will sound denser. To enhance percussion, use
high settings of DIFF. For clearer, more natural vocals, mixes, and music, use low or moderate
settings.

PDLY (Predelay) 0 - 1000ms
PDLY adjusts an additional time delay between the input of signal and the onset of reverbera-
tion. The control is not intended to mimic the time delays in natural spaces. In real rooms  the
build-up of reverberation is gradual, and the initial time gap is usually relatively short. Natural
spaces are best emulated by setting SHAP at a middle value and adjusting SPRD for the desired
effective pre-delay.
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Additional delay added with the PDLY control can increase the initial time gap slightly,
emulating a situation where reverberant pick-up microphones are located much further from
the source than the main microphones. If less than about 30ms of pre-delay is added, this
additional delay can add clarity with some music, but it can also sound unnatural. Large pre-
delays can be useful for slap-echo effects.
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Compressor

General Description
The Compressor effect is a true digital compressor which will run in either Dual Mono or
Cascade mode. In Dual Mono mode, it configures to Mono in Mono out; in Cascade mode, it
configures as a true stereo effect. The compressor can be described as an upwards averaging
compressor. Digital compressors, like analog compressors, decrease audio above a given
threshold. Unlike analog compressors, they increase gain below the threshold. The result from
either analog or digital compression is exactly the same — less dynamic range.

The audio path takes two routes. One path goes through a predelay mechanism which delays
the audio a maximum of 48 ms. The other path sends control information (dependent on the
CmpGain and ExpGain.  As the signal crosses the threshold point, both Compressor Gain and
Expansion Gain vary constantly. Compressor Gain determines the maximum amount of gain
increase below the threshold; Expansion Gain determines the maximum amount of gain
attenuation below the threshold.

Generally, digital compression requires lower threshold settings than analog compression.
The reason for this is that there is no such thing as headroom in a digital system — dBfs (Digital
Full scale [0VU]) is the maximum level audio. Audio dynamics below full scale, however, can
be manipulated and modified.

The whole purpose of a digital compressor is to maintain peaks while compressing lower level
audio signals upwards. If you think about it in terms of the most significant and least significant
bits, you would never want to reduce the most significant bits — you want to increase the least
significant bits.

Adding some predelay gives the control mechanism time to react before the audio reaches the
digital VCA. Of course, the more predelay you add, the more “out of sync” the audio will
become. Attack constants should be kept to short values (7,15, or 30ms). A good starting point
for release time is 91 or 114 ms.
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Compressor Parameters
PDLY (Predelay) 0 - 48ms
PDLY sets the predelay of the audio before the digital VCA.

The Compressor
SLOPE 1.0 - 99.99 : 1
SLOPE controls the slope of the gain reduction curve or the ratio of input level versus output
level.

THRS (Threshold) 0 to -40dB
THRS sets the level at which compression starts.

ATTACK0 - 960ms
ATTACK adjusts the attack time constant.

RELEASE(Release Time Constant) 0 - 4000ms
RELEASE allows adjustment of the release time constant.

CmpGain (Compressor Gain) 0 - 24dB
CmpGain adjusts the gain of low level signals (below the compression threshold).

TheExpander
X SLOPE (Expander Slope) 1.0 - 8.93 : 1
X SLOPE controls the slope of the expander circuit.

X THRS (Expander Threshold) 0 to -70dB
X THRS sets the threshold at which the expander starts to work.

ExpGain (Expander Gain) 0 - 24dB
ExpGain sets the amount of negative gain below threshold.
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PONS

GeneralDescription
Dither is a low-level pseudo-random signal which is added to digital audio to reduce
quantization noise, in effect, by replacing it with a “nicer sounding” noise. It is possible to filter
the quantization noise in such a way that almost all of the noise within the frequency range
where human hearing is most acute is shifted to higher frequencies. This is called psychoacous-
tically optimized noise shaping (PONS) because it takes advantage of the variations in the ear’s
sensitivity to noise within the 20 Hz - 20 kHz range.

PONS Parameters
DITH (Dither Gain) 0 - 254
DITH allows you to vary the amount of dither gain added to the signal.

PONS On/Off
The PONS control allows you to turn the dither function on or off.
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Mode 1: OMNI ON, POLY Mode 2: OMNI ON, MONO O : Yes
Mode 3: OMNI OFF, POLY Mode 4: OMNI OFF, MONO X : No

Lexicon NuVerb

Function Transmitted Recognized Remarks

Basic Default X Off
Channel Channel X 1-16, OMNI Any combination

Mode Defaullt X X
Messages X X
Altered X X

Note X X
Number True Voice X X

Velocity Note ON X X
Note OFF X X

After Keys X X
Touch Channels X X

Pitch Bender X O

Control 0-95 X O
Change

Program X X
Change True # X O

System Exclusive X X

System :Song Pos X X
:Song Sel X X

Common :Tune X X

System :Clock X X
Real Time :Commands X O

Aux :Local ON/OFF X X
Messages :All Notes OFF X X

:Active Sense X X
:Reset X X

Notes:

MIDI Implementation
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Time Code Applications

About time Code
Time Code is an electronic signal applied to tape or film which identifies each individual video
frame. The ability to uniquely identify any frame provides a reference system for fast and
accurate location of any point on the tape. This referencing system maintains its accuracy
regardless of changes in playback or editing equipment, allowing precise synchronization of
an entire editing system.

Time Code identifies each video frame by assigning it a unique “address”. Frames are
sequentially identified by hour, minute, second, and frame. For example, a typical Time Code
address appears as:

09 : 42 : 31 : 07
hours minutes seconds frames

As each frame is advanced, the Time Code address is increased by one frame “count”. Because
the Time Code signal is locked to advancing video frames, both advance at exactly the same
rate.

In the USA, there are two standard frame rates, one for black and white (monochrome), and
one for color.

Monochromatic video runs at a rate of 30 frames per second. If a black and white TV program
is measured by Time Code, the program length, the Time Code display, and clock time, will
all be in sync.

Color video signals run at a rate of 29.97 frames per second, and clocking a one-hour color
program at 30 frames per second will result in a time discrepancy of 3.6 seconds (or 108 frames).
In order to correct this discrepancy, a version of Time Code called SMPTE Drop Frame was
developed.
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SMPTE Drop Frame Time Code, as its name implies, eliminates frame addresses from the Time
Code each hour to allow matching of Time Code and clock time. Specifically, frame addresses
00 and 01 are eliminated at the end of every minute in an hour, except for minutes 00, 10, 20,
30, 40, and 50. For example, 00:00:59:29 advances to the number 00:01:00:02. In Drop Frame
mode, the frame numbers 00 and 01 do not exist, except for minutes 00, 10, 20, 30, 40, and 50.
Since Drop Frame Time Code eliminates only frame addresses, the actual video is unaffected.
Color videoframes continue to progress at the rate of 29.97 per second. Any calculations of
program length based on Drop Frame Time Code will, therefore, agree with standard clock
time.

Time Code Formats

SMPTE Non-Drop SMPTE Standard Time Code, compatible with a monochromatic
frame rate of 30 frames per second

SMPTE Drop Frame SMPTE Standard Drop Frame Time Code, compatible with a color
frame rate of 29.97 frames per second

EBU Compatiblewith the European broadcast standard frame rate of 25
frames per second

Film Compatible with frame rates of 24 frames per second
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Synchronizing MIDI
For synchronization the MIDI specification provides for MIDI Clock, MIDI Clock with song
pointer information, and MIDI Time Code. Other manufactures have provided their own
proprietary methods of MIDI synchronization, the most common being OMS by Opcode, and
DTL by Mark of the Unicorn.

To Synchronize NuVerb Automation you need:

• A source of MIDI Time Code. Regular Time Code must be convertedto MIDI Time Code,
(Seebelow.)

• A Midi Interface for your computer

(For information on using MIDI Manager to connect the MIDI Time Code source to
NuVerb see: About MIDI Manager)

NuVerb Uses MIDI Time Code for synchronization. It must be connected to the program using
the MIDI Manager™ from an external source. A MIDI interface is required to get your source
of MIDI Time Code into the computer. Many of the more sophisticated MIDI interfaces also
provide synchronization capabilities, often with MIDI Time Code as one of the options.

Sources of Time Code for synchronizing NuVerb
Many sources of Time Code exist. A sampling is presented below. Most of these sources,
however, do not provide MIDI Time Code, and their time code will, therefore, require
conversion for NuVerb.

Possible sources of Time Code for NuVerb:

• A multitrack tape analog or digital with Time Code recorded on one of the tracks

• A Digital tape deck (ADAT, DA88 etc) that outputs Time Code

• A Hard Disk Recorder/Digital Audio Workstation(DAW) that outputs Time Code

• Time Code that your tape deck or (DAW) is synchronizing to, often from a video source
or from another audio source.
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Converting Time Code To MIDI Time Code
There are a number of products that convert Time Code To MIDI Time Code, such as:

• MIDI Interfaces -Many of the more sophisticated MIDI interfaces also provide conversion
capabilities

• Stand alone converters that work with existing MIDI interfaces

• Time Code synchronizer — these mechanically synchronize tape decks to Time Code.
Some also output MIDI Time Code.
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MIDI Interface Sources

Manufacturer Model Comments

Adams-Smith, 34 Tower St., Hudson MA 02179 Zeta 3 o/p MTC
Electric Willy MTC-LTC converter

Alesis, 3630 Holdridge Ave., Los Angeles CA 90016 BRC ADAT controller o/p MTC

Atari, P.O. Box 61657, Sunnyvale CA 94088 SMPII o/p MTC

Fostex, 15431 Blackburn Ave., Norwalk CA 90650 4050 o/p MTC
MR-8 o/p MTC

J. L. Cooper, 12500 Beatrice St., Los Angeles CA 90066 PPS-2 o/p MTC
PPS-100 o/p MTC
SyncLink o/p MTC
Data Sync MTC output for ADAT
Data Master Pro sync for Atari

Mark of the Unicorn, 1280 Mass.Ave., Cambridge, MA 02138 MTP Mac Interface: o/p MTC
MTPII Mac Interface: o/p MTC
Video Time Piece Mac Interface: o/p MTC
Express Mac Interface: o/p MTC

MIDIMAN, Suite 108, 236 W. Mountain, Pasadena CA 91103 Syncman Mac Interface: o/p MTC
Syncman Plus Mac Interface: o/p MTC
Syncman Pro Mac Interface: o/p MTC

Opcode Systems, 3641 Haven St. A, Menlo Park CA 94025 Studio 3 Mac Interface: o/p MTC
Studio 4 Mac Interface: o/p MTC
Studio 5 Mac Interface: o/p MTC

Roland, 7200 Dominion Circle, Los Angeles CA 90040 SBX-80 MTC Converter

Steinberg Jones, Suite 1001, 17700 Raymer St., Northridge, CA 91325 Mac MIDI IIS specifically for Atari

Tascam (TEAC), 773 Telegraph Rd., Montbello CA 90640 SY-88 Sync Card Access. (RS-422),TC,Video, MIDI
MMC-100 o/p MTC
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About MIDI Manager
MIDI Manager is an Apple System Folder startup document that allows you to run several
MIDI applications at once. It allows you to send MIDI data from one program to another. In
NuVerb this is used for synchronization via MIDI Time Code.

MIDI Manager has three components: The Apple MIDI Driver, MIDI Manager™, and
PatchBay. PatchBay™ has an optional Help application.

On Apple System 7, the Apple MIDI Driver must be in the top level of the system folder, i.e.
not nested inside a folder in the system folder. MIDI Manager should be placed in the
Extensions folder found inside the System folder. After installation, it is necessary to re-start
your computer to enable MIDI Manager™.

You can have more than one MIDI driver in your system folder, and use one on the printer port
and one on the modem port. This can be an area of system setup confusion, so proceed with
caution if using this approach.
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Appendix

Troubleshooting
Hardware Verification

Check off these items:
■ Card correctly seated in NuBus socket with no bent pins

■ Digidesign Expansion chassis correctly installed and functioning properly (if applicable)

■ Audio source has AES output capability

■ NuVerb AES I/O cable correctly connected to AES source/destination

■ Audio monitoring device correctly connected to receive NuVerb output.

■ NuVerb passes audio

Check to make sure the board is passing audio
The NuVerb board should pass audio as soon as the Mac is powered up.  By connecting any
AES signal source and monitoring the output, you can verify that the board is receiving power
and that the AES I/O is OK. This can be done without installing or running the software
application.

Note: To connect an analog source to NuVerb, an external A/D-D/A converter with AES I/O will be
required. If you are installing NuVerb with a digital source that uses a format other than AES,
a format converter will be required.



LexiconAppendix

2

A-2

Hardware Troubleshooting
If you do not get audio output, perform the following checkout procedure.

1. Recheck the cables and the audio connections of the entire signal chain. Verifying that the
individual parts of the chain work independently is often helpful.

2. Remove the board, observing all installation precautions in regard to static, power down
etc. Check for bent pins on the edge connector. If the pins are bent, contact Lexicon
Customer Service at (617) 736-0300.

3. If the connector pins are OK, reinstall. Carefully seat the board, re-boot the Mac and retry
the audio pass-through test.

4. If you are using the Digidesign Expansion chassis, use the “Expansion View™” applica-
tion to verify that the card is being recognized by the Expansion chassis as well as the Mac.

5. Proceed to software installation to enable futher testing.

Software Verification

Check off these items:
■ Compressed application file copied to hard drive and decompressed

■ MIDI Manager placed in System Extensions folder

■ MIDI Manager Patchbay placed in the Apple Menu Items folder

■ Apple MIDI Driver placed in the System folder (not “nested” in another folder within the
System folder)

■ Double click on the NuVerb application icon to open; select Create Default Library from
the Options menu

■ Start your audio source and verify NuVerb is producing reverb
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In general, all you need to run NuVerb is the NuVerb application and MIDI Manager (supplied
with NuVerb). Watch out for System folder conflicts. If there is an installation problem, it is
probably here.

The application itself is supplied in a compressed form on a floppy disk and must be copied
to the Mac hard drive and decompressed to run. The NuVerb icon verifies that the application
is present in its decompressed form.

Open NuVerb by double clicking on the application icon. When the application opens, select
Create Default Library from the Options menu.  Single click on Large Hall, to load the
program. If your source of audio is correctly connected and playing, you should hear the Large
Hall reverb sound. This completes the verification procedure for NuVerb.  If you encounter
difficulties, check through the items below.

Software Troubleshooting
If the application opens, but you do not hear audio, re-check cables, audio source connections,
and the  entire signal chain.

If the application does not open, or immediately quits or locks up, refer to the items below. —
a System folder conflict is likely.

The System folder must contain certain items for NuVerb to run. Check for the following:

1. Verify that the Apple MIDI Driver is present in the top level of the System folder, i.e. not
inside another folder inside the System folder.

In theory, MIDI Manager will allow the use of multiple MIDI Drivers. However, if there
are any other MIDI drivers (Mark of the Unicorn, and Opcode among others provide their
own MIDI Manager Drivers), remove them and try running NuVerb with the Apple MIDI
Driver provided.

2. Verify that MIDI Manager is in the Extensions folder located in the System folder.

MIDI Manager allows NuVerb to receive MTC (MIDI Time Code). Other applications
(such as OMS) use MIDI Manager to send timing information between applicaitons.
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3. Verify that PatchBay™ is placed inside the Apple Menu folder and that it is present in the
Apple menu. If you are unfamiliar with MIDI Manager patching, you also place Patchbay
Help™ in the Apple menu.

4. Remove all System Extensions, except MIDI Manager, and re-boot. If NuVerb works
properly, begin replacing the extensions one at a time, re-booting each time to determine
which extensions are in conflict.
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Specifications
AES/EBU Interface
Sample Rates: 44.1 kHz or 48 kHz +5%
Slave only — All Channel Status and User bits are

passed through; they are neither observed nor modified.
Conforms to both the AES ANSI S 4.40-1985 specification,

and the EBU doc. tech. 3250. Both input and output are
transformer-coupled. Input and output levels and impedance
comply with CCITT V.11 EIA-422A specifications.

Digital Audio Connections
XLR - DB-9, cable provided

Data Resolution
20-bit wide internal data path

Control Interfaces
MIDI
MIDI Manager
Mac NuBus OMS
MIDI Time Code

Power Requirements
+5v @ 1.5A and +12v @ 50mA
+5v+3% (4.90-5.20v) DC
+12v+3% (11.50-12.80v) DC
Line Voltage: 90-140 and 170-270 volts (RMS)
Line Frequency: 47-60 Hz

FCC Rating
Class A

Physical Dimensions
4.0"W x 12.875"L  x 0.6"H (Mac NuBus)

Operating Temperature Range
50-95°F (10-35°C)

Specifications subject to change without notice.
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